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Introduction to the Application Related Documentation

Related Documentation
The following manuals are available as part of the TekExpress D-PHY Automated Solution documentation
set.

Table 1: Product documentation
Item Purpose Location
Online Help In-depth operation and UI help.

PDF of the Online Help
(077-0514-XX)

In-depth operation and UI help.

+
xxx

Conventions
Online Help uses the following conventions:

The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the two mechanical methods of choosing an option:
using a mouse or using the touch screen.

A Note identifies important information.
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Introduction to the Application Technical Support

Technical Support
Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or comments on your application or oscilloscope.

When you contact Tektronix Technical Support, please include the following information (be as specific as
possible):

General Information
All instrument model numbers.

Hardware options, if any.

Probes used.

Your name, company, mailing address, phone number, FAX number.

Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application Specific Information
Software version number.

Description of the problem such that technical support can duplicate the problem.

If possible, save the setup files for all the instruments used and the application.

If possible, save the TekExpress setup files, log.xml , *.TekX (session files and folders), and status
messages text file.

If possible, save the waveform on which you are performing the measurement as a .wfm file.

Forward the information to technical support using one of these methods:

E-mail – techsupport@tektronix.com

FAX – (503) 627-5695
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Getting Started Compatibility

Compatibility
The TekExpress D-PHY application runs on the following Tektronix oscilloscopes:

MSO71254C, MSO71604C, and MSO72004C Series Mixed Signal Oscilloscopes

DPO/DSA71254C, DPO/DSA71604C, and DPO/DSA72004C Series Digital Oscilloscopes

MSO70404, MSO70604, MSO70804, MSO71254, MSO71604, and MSO72004 Series Mixed
Signal Oscilloscopes

DPO/DSA70404B, DPO/DSA70604B, DPO/DSA70804B, DPO/DSA71254B, DPO/DSA71604B,
and DPO/DSA72004B Series Digital Oscilloscopes

DPO/DSA70404, DPO/DSA70604, DPO/DSA70804, DPO/DSA71254, DPO/DSA71604, and
DPO/DSA72004 Series Digital Oscilloscopes

DPO7254 1 and DPO7354 Digital Oscilloscope
1 The DPO7254 oscilloscope may not meet the Rise/Fall time specifications of D-PHY standards. If that is not critical, then you can use the

DPO7254 oscilloscope for the D-PHY measurement.

The TekExpress D-PHY application supports the following Tektronix probes:

TAP1500

P7240

P6245

P7380A

P7508 (supports HS-tests only, with known limitations for DSI DUTs)

TDP3500

Minimum System Requirements
The minimum system requirements for a PC to run TekExpress are as follows:

Processor Pentium 4/M or equivalent processor.
Operating System Windows XP Service Pack 2.
Memory 512 MB of memory.
Hard Disk Approximately 2 GB of available hard-disk space for the recommended

installation, which includes full TekExpress installation and distributed
components.

Drive DVD drive.
Display Super VGA resolution or higher video adapter (800x600 minimum video

resolution for small fonts or 1024x768 minimum video resolution for large fonts).
The application is best viewed at 96 dpi display settings 1.
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Getting Started Install the Software

Software Microsoft Excel 2002 or above.

Microsoft Internet Explorer 6.0 SP1 or later.

Microsoft Photo Editor 3.0 or equivalent software for viewing image files.

Adobe Reader 6.0 or equivalent software for viewing portable document
format (PDF) files.

Other Devices Microsoft compatible mouse or compatible pointing device.

Four USB ports (two USB ports minimum).

PCI-GPIB or equivalent interface for instrument connectivity 2.
xxx

1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, sampling oscilloscope), it is recommended
to connect a secondary monitor and this must be enabled before launching the application.

2 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port will be used by TekExpress for communicating with oscilloscope
applications. If external GPIB communication devices like USB-GPIB-HS or equivalent are used for instrument connectivity, ensure that the Talker
Listener utility is enabled in the DPO/DSA oscilloscope’s GPIB menu. For ease of use, connect to an external (secondary) monitor.

Install the Software
1. Close all applications.

2. Download D-PHYWebinstaller_<version>.EXE.

3. Double-click the executable to extract the files. After extraction, the installer launches and the software
is installed in C:\Program Files\Tektronix\TekExpress\TekExpress D-PHY.
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Getting Started Application Directories and Usage

Application Directories and Usage
The application directory and associated files are organized as follows:

The following table lists the default directory names and their usage:

Directory names Usage
InstallDir\TekExpress\TekExpress D-PHY Contains the application and associated files.
TekExpress D-PHY\Compliance Suites Contains compliance specific files.
TekExpress D-PHY\Bin
TekExpress D-PHY\Lib
TekExpress D-PHY\Tools

Includes the Miscellaneous libraries of the D-PHY application.
Includes utility files specific to the D-PHY application.
Includes instrument application specific files for the D-PHY
application.

TekExpress D-PHY\ACP
TekExpress D-PHY\SCP
TekExpress D-PHY\ICP

Includes instrument and application specific interface libraries of
the D-PHY application.

TekExpress D-PHY\Documents Includes the technical documentation for the application.
TekExpress D-PHY\Data Manager
TekExpress D-PHY\Data Storage
TekExpress D-PHY\Report Generator

Includes the result management specific libraries of the D-PHY
application are present in these folders.
Includes Excel Active X interface Library for Report Generation.

Includes the filter files for the D-PHY application.
xxx

TekExpress D-PHY Automated Solution 5



Getting Started Folder Structure

Folder Structure
After you install D-PHY, it creates the following folders on your computer:

\Program Files\Tektronix\TekExpress\TekExpress D-PHY.

NOTE. Ensure that the “TekExpress” folder has read and write access.

\My Documents\My TekExpress\D-PHY.

\My Documents\My TekExpress\D-PHY\Untitled Session.

Every time the TekExpress D-PHY.exe is launched, an Untitled Session folder is created under
D-PHY folder. The Untitled Session folder is deleted when you exit the D-PHY application.

CAUTION. Each session has multiple files associated with it. Do not modify any of the session files and/or
folders as this may result in loss of data or corrupted session files.

The My TekExpress folder is created as a shared folder with share name as <domain><user ID>My
TekExpress (or if the PC is not connected to domain, then share name is <Computer name><user

ID> My TekExpress).

The above shared folder is mapped as X: (X drive) on to the instrument where D-PHY is running.

NOTE. If X drive is mapped to any other shared folder, the application will display a warning message
window asking you to disconnect the X: drive manually.
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File Name Extensions
The software uses the following file name extensions:

File name extension Description
.TekX The session file will be saved in this format.
.seq The test sequence file.
.xml The encrypted XML file that contains the test specific configuration

information.
The log file extension is also xml.

.wfm The test waveform file.

.mht The test result report will be saved in this format.

.flt The filter files are in this format.
xxx

Activate the License
Follow the steps below to activate the license:

1. Click Help > Activate License or Help > About TekExpress > License Info to view the license
information and activate the application.

2. Click the View Version Details link to check the version numbers of the installed test suites.
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3. Click the View End-User License Agreement link to open the following Tektronix Software License
Agreement window. Click Print to print the License Agreement.

4. Click License Info to view the available software options. This window shows the license key and
supported options with their status (active or inactive) with the current license key.
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5. If you are activating the license for the first time, the license key field will be empty. To activate the
license, connect the USB dongle to your computer, enter the license key provided in the license key
certificate, and click Activate. If the activation is successful, a sign is displayed next to the license
key field.

6. If you are reactivating the license, click Reactivate, enter the new license key and click Activate.

Before You Click Run
Do the following before you click Run:

NOTE. Ensure that the network connectivity is enabled on the instrument running the D-PHY application.

1. Map (see page 9) the shared My TekExpress folder as X: (X drive) on all the instruments used in test
setup running Microsoft Windows Operating System. This shared folder is used to save the waveform
files or used during any other file transfer operations.

2. Right-click on the My TekExpress folder and open the Properties dialog box. Select the General tab
and then Advanced. In the Advanced Attributes window, ensure that the option Encrypt contents to
secure data is NOT selected. Click here (see page 10) to view the picture.

3. Ensure that all the required instruments are properly warmed up, Signal Path Compensation (SPC) (see
page 10) performed, followed by cable deskew.

Mapping My TekExpress Folder
To map the My TekExpress folder on the instruments, follow the steps below:

1. Open Windows Explorer.

2. From the Windows Explorer menu, select Tools > Map Network drive.

3. Select the Drive letter as X: (if there is any previous connection on X:, disconnect it first through
Tools > Disconnect Network drive menu of Windows Explorer).

4. In the Folder field, enter the remote My TekExpress folder path (for example, \\192.158.97.65\
John’s My TekExpress)

5. To determine the IP address of the PC where “My TekExpress” folder exists, do the following:

Select Start > Run menu on the PC where the My TekExpress folder exists.

Enter cmd and press Enter.

At the command prompt, type ipconfig.
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To find SPC, do the following:

1. On the oscilloscope main menu, select the Utilities menu.

2. Click the Instrument Calibration option.
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D-PHY Application Overview
TekExpress is the Tektronix Test Automation Framework, developed to support your current and future
test automation needs. TekExpress uses a highly modular architecture that lets you deploy automated test
solutions for various standards in a relatively short time.

Key Features
The key features of the D-PHY application are:

Allows conformance testing to the latest Compliance Test Specification (CTS)

Comprehensive test coverage performing 40 out of 49 total conformance tests to the latest CTS.
(81% tests coverage)

Automated testing:

Eliminates user intervention to conduct time-consuming testing

Reduces the time required to conduct testing

Enables you to test devices faster

Automated temperature chamber testing provides automated setup to validate all High Speed tests
using XL cables, temperature tips and standard filter files

Customizing the setup:

Allows you to modify the test setup as per the DUT configuration

Automatically calculates unit intervals based on the DUT data rates

Margin testing and characterization:

Allows custom-limits or limits-editing to perform Margin testing

Performs characterization of your design

Flexible probing allows you to probe your Design Under Test (DUT) using either Differential or
Single-ended probes.

Selective testing:

Performs fully-automated testing for transmitter measurements

Allows you to select individual tests or test groups in the tree-structure

Avoids repeated testing, through accurate and reliable results from a single run

Escape mode support allows you to perform both Escape Mode (ULPS Mode) and the Normal Mode
tests.
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Clock Continuous Mode support allows you to perform all tests in normal mode or selective tests
in Clock Continuous mode

Detailed test reporting:

Provides a Pass/Fail summary table

Provides margin details on each test

Provides a consolidated report for all tests

Starting the Application
The application uses a USB dongle that contains the license key. This dongle must be present on the
instrument hosting the D-PHY application.

The application also checks for a file, called Resources.xml, located in My TekExpress folder. If this file is
not found, instrument discovery is performed before launching D-PHY. The Resources.xml file contains
information regarding instruments available on network.

When the application starts, it checks for the appropriate license key. If the valid license key is not
present, the application switches to the “Evaluation” mode. If the application fails to detect the dongle, it
continues to run in Evaluation mode.

Start the application in one of the following ways:

Click Start > Programs > Tektronix > TekExpress > TekExpress D-PHY.

Double click the icon on the desktop.

If you have previously saved a session, double-click the session file stored under My
TekExpress\D-PHY.
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NOTE. If the application was not terminated properly during the last use, a dialog box asks to recall the
previously unsaved session.

Resizing the Application Window

To minimize the application, click on the application title bar. To restore the application to its previous

size, select in the Windows task bar.

To maximize the application, click . To restore the application to its previous size, click on the
application title bar.

Exiting the Application
To exit the application, do one of the following:

Click File > Exit.

Click on the application title bar.

NOTE. Using other methods to exit the application results in abnormal termination of the application.
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Global Controls
The menus and controls that appear outside the individual tabs are called “Global Controls”. These are
used to specify the devices to be tested.

Table 2: Global controls
Control name Function
DUT The device ID is specified at the global level and the

information is stored in the default location for all data
files. This field cannot be empty and does not allow these
special characters (.,..,...,\,/:?”<>|*). The maximum length
of characters allowed is 32.
Displays the status of the disk space. When the disk space
is low, a warning dialog appears to perform the cleanup and
continue working on the application.
You will be able to run, pause, resume, and stop the tests.

xxx

Menus

File Menu
Click File on the application menu bar.
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The File menu has the following selections:

Menu Function
New Session Starts a default session of D-PHY.
Open Session Opens a saved session.
Save Session Saves the session.
Save Session As Saves a session in a different name.
Recently Recalled Setup Recalls the recently saved setup.
Save Report As Saves the report in user specified location.
Print Preview Report Previews the report before printing.
Print Report Opens the Windows “Print” dialog box.
Exit Closes the application.
xxx

View Menu
Click View on the application menu bar.

The View menu has the following selections:

Menu Function
Log Opens the log (log.xml) file in the default viewer.
xxx

Tools Menu
Click Tools on the application menu bar.

The Tools menu has the following selections:

Menu Function
Instrument Bench (see page 16) Shows the list of instruments connected to the test setup.
E-mail Setting (see page 16) Allows you to configure and set the e-mail options.
xxx
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Instrument Bench
The Instrument Bench window shows the list of VISA and Non-VISA resources found on different
interfaces/connections. It serves two purposes at the launch of TekExpress:

Discovers the connected instruments.

Confirms the instrument connection setup.

When you click Tools > Instrument Bench, the following dialog box is displayed:

E-mail Settings
The E-mail Settings utility allows you to configure and set the e-mail options. The following fields are
mandatory for receiving e-mail notification from TekExpress:

1. Recipient Email Addresses. For example, User@domain.com

2. Sender’s Address

3. SMTP Server address of the Mail server configured at client location
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If any of the above mentioned fields are left blank, the settings will not get saved and e-mail notification
will not be sent.

Check the option “E-mail Test Results When Complete or on Error” to receive the e-mail. The attachment
list depends on the choice which is made while configuring the email setup.

NOTE. The Analysis Screenshot option in the Add Email Attachments pane is not yet functional.

Help Menu
Click Help on the application menu bar.

The Help menu has the following selections:

Menu Function
TekExpress Help Displays TekExpress Help (F1).
About TekExpress Displays the TekExpress screen with the application title.

Also displays the application details such as software name,
version number, and copyright.

Activate License (see page 7) Displays the details of activating the application.
xxx
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Select Test(s)
The application supports the following D-PHY tests:

Group 1 tests that are Single-ended tests and available only in the Escape mode:

1.1.1 Data Lane LP-TX Thevenin Output High Level Voltage (VOH)

1.1.2 Data Lane LP-TX Thevenin Output Low Level Voltage (VOL)

1.1.3 Data Lane Rise Time

1.1.4. Data Lane Fall Time

NOTE. Group 1 tests are supported on LP-HS waveforms although it is not recommended to use LP-HS
waveforms for these tests.

Group 2 tests that are Single-ended tests and available only in the Escape mode:

1.2.1 Clock Lane LP-TX Thevenin Output High Level Voltage (VOH) (Single-ended only)

1.2.2 Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL) (Single-ended only)

1.2.3 Clock Lane Rise Time (Single-ended only)

1.2.4. Clock Lane Fall Time (Single-ended only)

NOTE. Group 2 tests are supported on LP-HS waveforms although it is not recommended to use LP-HS
waveforms for these tests.

Group 3 tests:

The following Group 3 tests are single-ended and differential tests, except where indicated:

1.3.1 Data Lane HS Entry: Data Lane TLPX Value

NOTE. The Data Lane HS Entry: Data Lane TLPX Value test is supported on LP-HS waveforms although
it is not recommended to use LP-HS waveforms for this test.

1.3.2 Data Lane HS Entry: THS-PREPARE Value

1.3.3 Data Lane HS Entry: THS-PREPARE+ THS-ZERO Value

1.3.4 Data Lane HS-TX Differential Voltages (VOD(0), VOD(1))

1.3.5 Data Lane HS-TX Differential Voltage Mismatch (ΔVOD)

1.3.6 Data Lane HS-TX Single-ended Output High Voltages (VOHHS(DP)), VOHHS(DN))
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1.3.7 Data Lane HS-TX Common Mode Voltages (VCMTX(1), VCMTX(0))

1.3.8 Data Lane HS-TX Common Mode Voltage Mismatch (ΔVCMTX(1,0))

1.3.9 Data Lane HS-TX Dynamic Common-Level Variations Between 50–450MHz (ΔVCMTX(HF))

1.3.10 Data Lane HS-TX Dynamic Common-Level Variations Above 450MHz (ΔVCMTX(HF))

1.3.11 Data Lane HS-TX 20%–80% Rise Time (tR)

1.3.12 Data Lane HS-TX 80%–20% Fall Time (tF)

1.3.13 Data Lane HS Exit: THS-TRAIL Value

1.3.14 Data Lane HS Exit 30%–80% POST-EoT Rise Time (TREOT)

Group 4 tests:

The following Group 4 tests are single-ended and differential tests, except where indicated:

1.4.1 Clock Lane HS Entry: TLPX Value (Single-ended only)

1.4.2 Clock Lane HS Entry: TCLK-PREPARE Value (Single-ended only)

1.4.3 Clock Lane HS Entry: TCLK-PREPARE+ TZERO Value (Single-ended only)

1.4.4 Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1))

1.4.5 Clock Lane HS-TX Differential Voltage Mismatch (ΔVOD)

1.4.6 Clock Lane HS-TX Single-ended Output High Voltages (VOHHS(DP)), VOHHS(DN))
(Single-ended only)

1.4.7 Clock Lane HS-TX Common Mode Voltages (VCMTX(1), VCMTX(0)) (Single-ended only)

1.4.8 Clock Lane HS-TX Common Mode Voltage Mismatch (ΔVCMTX(1,0)) (Single-ended only)

1.4.9 Clock Lane HS-TX Dynamic Common-Level Variations Between 50–450MHz (ΔVCMTX(LF))
(Single-ended only)

1.4.10 Clock Lane HS-TX Dynamic Common-Level Variations Above 450MHz (ΔVCMTX(HF))
(Single-ended only)

1.4.11 Clock Lane HS-TX 20%–80% Rise Time (tR)

1.4.12 Clock Lane HS-TX 80%–20% Fall Time (tF)

1.4.13 Clock Lane HS Exit: TCLK-TRAIL Value

1.4.14 Clock Lane HS Exit 30%–80% POST-EoT Rise Time (TREOT) (Single-ended only)

1.4.17 Clock Lane HS Clock Instantaneous (UIINST)

Group 5 tests:

The following Group 5 tests are single-ended and differential tests, except where indicated:

1.5.1 HS Entry: TCLK PRE Value

1.5.2 HS Entry: TCLK POST Value
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1.5.3 HS Clock Rising Edge Alignment to First Payload Bit

NOTE. Group 5 tests are not available in the Clock Continuous mode.

The following table lists the tests (ids) that are supported in the clock and test modes:

Clock mode Test mode Test ids
Single-ended tests: Group 3, Group 4, and Group 5.
Test ids: 1.3.1, 1.3.2, 1.3.3, 1.3.4, 1.3.5, 1.3.6, 1.3.7,
1.3.8, 1.3.9, 1.3.10, 1.3.11, 1.3.12, 1.3.13, 1.3.14.
Test ids: 1.4.1, 1.4.2, 1.4.3, 1.4.4, 1.4.5, 1.4.6, 1.4.7,
1.4.8, 1.4.9, 1.4.10, 1.4.11, 1.4.12, 1.4.13, 1.4.14, 1.4.17.
Test ids: 1.5.1, 1.5.2, 1.5.3.

Normal Normal

Differential tests: Group 3, Group 4, and Group 5.
Test ids: 1.3.2, 1.3.3, 1.3.4, 1.3.5, 1.3.7, 1.3.8, 1.3.9,
1.3.10, 1.3.11, 1.3.12, 1.3.13, 1.3.14.
Test ids: 1.4.4, 1.4.5, 1.4.11, 1.4.12, 1.4.17.
Test ids: 1.5.1, 1.5.2.

Normal Escape Single-ended tests: Group 1, Group 2, and Group 3.
Test ids: 1.1.1, 1.1.2, 1.1.3, 1.1.4 Test id: 1.2.1, 1.2.2,
1.2.3, 1.2.4.
Test id: 1.3.1
Single-ended tests: Group 3 and Group 4.
Test ids: 1.3.1, 1.3.2, 1.3.3, 1.3.4, 1.3.5, 1.3.6, 1.3.7,
1.3.8, 1.3.9, 1.3.10, 1.3.11, 1.3.12, 1.3.13, 1.3.14.
Test ids: 1.4.4, 1.4.5, 1.4.6, 1.4.7, 1.4.8, 1.4.9, 1.4.10,
1.4.11, 1.4.12, 1.4.17.

Continuous Normal

Differential tests: Group 3 and Group 4.
Test ids: 1.3.2, 1.3.3, 1.3.4, 1.3.5, 1.3.7, 1.3.8, 1.3.9,
1.3.10, 1.3.11, 1.3.12, 1.3.13, 1.3.14.
Test ids: 1.4.4, 1.4.5, 1.4.11, 1.4.12, 1.4.17.

xxx

TekExpress D-PHY Automated Solution 21



How To Select Test(s)

Use the Select panel to select configure, and run one or more groups of tests.

Select Device. Select the device type from the list: D-PHY CSI-2 or D-PHY DSI. The default value is
D-PHY-CSI-2. Enter the DUT ID for the device.

Select Clock Mode. Select the Clock Mode: Normal or Continuous. Select Continuous when the signal has
only the high speed region. Select Normal when the signal has both, the high speed and the low power
regions. The application uses Edge trigger for Continuous mode and Transition trigger for Normal mode.
The default Sample rate is 12.5 Gs/s and the default Record Length is 1M.

Select Clock Lane Probing. Select the probing method: Differential or Single-Ended. Based on this
selection, the application displays the single-ended and differential tests. If probing type is Single-ended
then you will need four probes (Dp, Dn, Clkp, Clkn). If probing type is Differential, then you will need
three probes (Dp, Dn, Clkp-Clkn). Group 1 and Group 2 tests are not available for the Differential
probing method

Select Test Mode. Select the test mode from the list: Normal or Escape. The default value is Normal.
Escape is available only when the Clock Mode is Normal. The application does not support Clock
continuous mode for Escape mode tests. As a result, the trigger is Transition trigger. When you select
Escape mode, you must connect a ULPS signal to the oscilloscope on which the measurements will be
done. However, the application can still perform the measurements on the LP-HS signals. The default
Sample rate is 12.5 Gs/s and the default Record Length is 1M.

Version. Select the Compliance Test Specification version, the default value is CTS 0.98. For the selected
CTS version, select any particular test, or one or more test groups.
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Table 3: Select panel buttons
Button Description

Opens the configuration panel for the selected test.

Opens the schematic for the selected test. This is useful if
you want to verify the test setup before running the test.
Selects all tests in the table.

Deselects all tests in the table.

xxx

Configure and Run the Test(s)
The configuration panel is used to view and edit the parameters associated with the acquisition and the
analysis of the selected test. Click here for the options.

NOTE. If any of the test parameters are grayed, it means that these parameters are not editable.
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The upper part of the Configuration Panel shows parameters and their values. These parameters are
common for a group of tests. Parameters specific to a select test are shown in the lower part of the
Configuration Panel. Test-specific parameters include acquisition, analysis, and limit parameters.

The following table lists the common parameters and their values:

Table 4: Common parameters and values
Parameter Value
Real Time Scope Select the oscilloscope to which to connect.
Measurement Method Select the measurement method: Automatic or Manual. In the

Automatic mode, you perform a test without any intervention. In
the Manual mode, you will be prompted to place the cursors on the
acquired waveform before the application proceeds with the analysis.

NOTE. The Manual method is available only in the User Defined
mode.

Filter File 1 (for testing in Temperature Chamber) Select the filter file to use for temperature chamber testing. Click on
the browse button in the field and select a file. If you select None, no
filter file is used (testing in temperature chamber is not considered).

NOTE. Filter file selection is available only in the User Defined mode.
Filter File 2 (for testing in Temperature Chamber
with Differential Probing)

Select the filter file to use with differential probing for temperature
chamber testing. Click on the browse button in the field and select a
file. If you select None, no filter file is used (testing in temperature
chamber is not considered).

NOTE. Filter file selection is available only in the User Defined mode.
xxx

NOTE. If you change the channel selection for Data+ (DP), Data– (DN), Clock+ (CP), and Clock–
(CN) signals, make sure that you change the trigger source correspondingly in the Analyze tab for each
of the measurements. If you do not do this, the waveform might not trigger and the measurements might
not be completed.

For temperature chamber testing, a filter file with S4 parameters is used to compensate the factors
introduced due to length of the probe cable when testing the DUT in temperature chamber. You will need
one or two filter files based on the selected clock probing. If you select Single-ended probing, you must
specify only one filter file (Filter File 1). The application ignores the Filter File 2 even if you provide it. If
you select Differential probing, then you must specify both the filter files (Filter File 1 and Filter File 2).

The following table lists the tabs and button controls for the tests:

Table 5: Configure panel buttons
Configure parameters Description
Acquire (see page 26) Shows the various parameters related to acquisition of a selected test.
Analyze (see page 28) Shows the various parameters related to analysis of a selected test.

These parameters can vary from one test to another test. For example,
Vertical scale, Vertical offset, Horizontal scale, and others.
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Table 5: Configure panel buttons (cont.)

Configure parameters Description
Limits (see page 27) Applies to a specific version. It shows the measurement lower and

upper limits using different types of comparisons like EQ(==), NE(!=),
GT(>), LT(<), GE(>=), LE(<=), GTLT(> <), GELT(>= <), GTLE(> <=),
LTGT(< >), LEGE(<= >=), LEGT(<= >), LTGE(< G=), GELE(>= <=).
Some use unary operands and some use binary operands. For unary
operands, only value1 (on the left) is active.

Comments Specify a comment up to 256 characters long for selected test.
Restore Restores the default values.
Save Saves and applies the configuration parameters that you have set.
Cancel Dismisses the dialog box.
xxx

Click Run in the Select panel to run the selected tests.

Refer to the following table for various test limit comparisons:

Table 6: Test limit comparisons
Comparison string Description
EQ(==) Equal to
NE(!=) Not equal to
GT(>) Greater than
LT(<) Less than
GE(>=) Greater than or Equal to
LE(<=) Less than or Equal to
GTLT(><) Greater than and Less than
GELT(>=<) Greater than or equal to and Less than
GTLE(><=) Greater than and Less or equal to
LTGT(<>) Less than and Greater than
LEGE(<= >=) Less than or equal to and Greater than or equal to
LEGT(<= >) Less than or equal to and Greater than
LTGE(< >=) Less than and Greater than or equal to
GELE(>= =<) Greater than or equal to and Less than or equal to
xxx
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Configure Acquire Panel

You have the following options:

Restore compliance mode values.

Change the parameters associated with analysis configuration.

Change the test limits in the User Defined mode.

Add comments for the selected test that would appear in the Report panel.

26 TekExpress D-PHY Automated Solution



How To Configure and Run the Test(s)

Configure Limits Panel
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Configure Analyze Panel

Typical Configuration Parameters
The following table shows the typical or default configuration parameters for single-ended and differential
tests in the clock normal and clock continuous modes.
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Single-ended tests
(Clock Mode Normal)

Single-ended
tests (Clock Mode
Continuous)

Differential tests
(Clock Mode Normal)

Differential tests
(Clock Mode
Continuous)

Acquire
parameters

Data
lane
tests

Clock
lane
tests

Data
lane
tests

Clock
lane
tests

Data
lane
tests

Clock
lane
tests

Data
lane
tests

Clock
lane
tests

Vertical
Scale (mV)

200 200 200 200 200 200 200 200

Vertical Position
for Data (div)

–2.6 NA –2.6 NA –2.6 NA –2.6 NA

Vertical Position
for Clock (div)

NA –2.6 NA –2.6 NA 2.6 NA 2.6

Vertical
Position (div)

–2.6 –2.6 –2.6 –2.6 2.6 2.6 2.6 2.6

Vertical Offset (V) 0 0 0 0 0 0 0 0
Horizontal Scale
(us)

8 8 8 8 8 8 8 8

Sample Rate
(GS/s)

12.5 12.5 12.5 12.5 12.5 12.5 12.5 12.5

Record Length 1000000 1000000 1000000 1000000 1000000 1000000 1000000 1000000
Analyze parameters
Trigger Type Transi-

tion
Transi-
tion

Transi-
tion

Edge Transi-
tion

Transi-
tion

Transi-
tion

Edge

Trigger Source Ch1 Ch3 Ch1 Ch3 Ch1 Ch3 Ch1 Ch3
Trigger Upper
Level (V)

1 1 1 NA 1 1 1 NA

Trigger Lower
Level (V)

0.05 0.05 0.05 0.05 0.05 0.05 0.05 0.05

Trigger Level for
Continuous Clock
Mode (V)

NA NA NA 0.2 NA NA 0.2 0.2

Trigger Time (ps) 500 500 500 500 500 500 500 500
Trigger Transition Greater

Than
Greater
Than

Greater
Than

NA Greater
Than

Greater
Than

Greater
Than

NA

Trigger Slope Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Positive,
Negative

Trigger If Violation Occurs Occurs Occurs NA Occurs Occurs Occurs NA
xxx
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View and Select Connected Instruments

Viewing Connected Instruments
The Tools > Instrument Bench menu item is used to discover connected instruments required for the
tests. The application uses TekVISA to discover the connected instruments. Once the operation is done,
the Instrument Bench dialog box resumes operation and lists the instrument-related details based on the
selected search criteria.

NOTE. When the TekVISA Instrument Manager checks for connected Instruments, the Instrument Bench
dialog box does not respond.

For example, if you select LAN and GPIB as the search criteria in the Instrument Bench dialog box and
click Refresh, the TekVISA Instrument Manager checks for the availability of instruments over LAN and
the details of the instruments are displayed under Retrieved Instruments table.

Provide the time in the TekVISA Refresh Timeout (Seconds) field, within which if the TekVISA
Instrument Manager does not find the instruments, the TekExpress application resumes the operation. If
you choose Non-VISA resources, all the instruments supported by TekExpress but not communicating
over the VISA layer can be searched.
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Selecting Connected Instruments

View the instruments connected in the Configuration panel. The upper half of the panel displays the
general parameters for the tests under the selected test suite. Select the Real Time Scope to connect to
from the drop-down list.

NOTE. The list of instruments displayed is specific to the selected test suite. It does not show all the
connected instruments.

Acquire Live Waveform for Analysis
Select the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock (Clkp
and Clkn) sources. When you click Run, by default the application acquires live signals from the source.

Click the Acquire tab to see acquisition parameters, and acquisition status of the selected test suite. The
Acquire panel is specific to a suite and gets updated every time the selected test suite is changed. This
panel shows the acquisition details for the tests in the currently selected suite. The tests with common
acquisition parameters are grouped together and shown as a single acquisition.
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Table 7: Controls on the Acquire panel
Selection Function
Data Source Lists the sources assigned for each data line (Dp and Dn).

Select the source (channel) for each data line (Dp and Dn).
Once you select a channel for Dp, you cannot select the
same channel for other lines (Dn, Clkp, and Clkn) and vice
versa).

Clock Source Lists the sources assigned for each clock line (Clkp and
Clkn). Select the source (channel) for each clock line (Dp
and Dn). Once you select a channel for Clkp, you cannot
select the same channel for other lines (Dn, Dn, and Clkn)
and vice versa).
If you have selected Differential Clock Lane Probing in
the Select panel, only one source selection is displayed
(differential probe clock needs only one channel as source).

Column Name
Test Displays the name of the selected test for performing

acquisitions. One or more tests can perform the same
acquisitions.

Status Acquisition status of the running test at intervals. The
messages are passed only in live acquisition.

Acquisition Updates the location of the acquisition name.
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Table 7: Controls on the Acquire panel (cont.)

Selection Function
Acquire Options
Use Pre-recorded Waveform Files When enabled, uses pre-recorded waveforms for the

selected test.
Acquire Step By Step When enabled, displays the reference input waveform of

the selected test. This helps you to compare the input
waveform with the reference waveform, allows you to
change the setup before acquiring the waveforms, and then
proceeds with the next selected test.

xxx

Use Prerecorded Waveforms for Analysis
Select the Acquire tab to see unique acquisitions, acquisition parameters, acquisition status, and
prerecorded waveform files of the selected test suite. The Acquire panel is specific to a group and gets
updated every time the selected test group is changed. This panel shows the acquisition details for the
tests in the currently selected group. The tests with the common acquisition parameters are grouped
together and shown as a single acquisition.

For pre-recorded testing, it is recommended that you capture the waveforms at 12.5 Gs/s sample rate.
However, if you capture the waveforms at a different sample rate, ensure that you change the Sample Rate
parameter in the Configure Panel appropriately for each of the selected tests.

NOTE. You can only use saved sessions in which the tests have been run in Automatic mode for prerecorded
testing. You cannot use the sessions in which tests have been run in Manual mode for prerecorded testing.

NOTE. You cannot use the prerecorded waveform option for the 1.5.3 HS Clock Rising Edge Alignment to
First Payload Bit test.

TekExpress D-PHY Automated Solution 33



How To Use Prerecorded Waveforms for Analysis

Column name Function
Test Name Name of the tests performing acquisitions. One or more tests can perform

the same acquisitions.
Acquisition Test acquisition status of the running test passed at intervals.
Waveform File Prerecorded waveform files of unique acquisitions. You can select waveform

files by clicking the hyperlink. This allows you to select any waveform file using
the standard file open window.

xxx

NOTE. To use the prerecorded option, it is recommended that you use a waveform file (.wfm) which has
been captured from a Tektronix oscilloscope. This eliminates the need to use an oscilloscope. You can
manually select waveforms and perform the tests with a click of the Run button.

The following Acquire source options are available:

Use Pre-recorded Waveform Files: Enabling or disabling the option shows or hides the waveform
file column in the acquisition table.
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Follow these steps to save a session and use the pre-recorded mode to run it:

a. Open a new session.

b. Select the tests.

c. Highlight a test and click Configure. Change the sample rate parameter to the desired value for
each of the selected tests.

d. Save the session.

e. In the Acquire panel, select Use Pre-recorded Waveform Files and then select the waveforms for
each of the tests. Make sure that the waveform names have a suffix DP, DN, CP, and CN indicating
the data and clock waveforms. For example.....

Acquire Step by Step: Selecting this prompts you at the end of each acquisition before proceeding
to the next one.

Show Acquire Parameters: Selecting this shows the acquisition parameters.

When you select “Use Pre-recorded”, the first column shows the Acquisition, the second column shows
the Test, and the next column shows the Waveform File for analysis.

View the Progress of Analysis
Click the Analyze tab to view the progress of the analysis. As the analysis of each test is complete, the
result value is updated.
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Analyze Table
The Analyze table contains the following:

The test name.

The status of the tests that are being run.

The low and high limit values, and margins, for the tests.

The measured values for the tests.

The pass/fail status of the tests.

The tests that are not yet started are shown with a “To be Started” status. A summarized status of the
currently running test is shown in the Status Messages panel.

The Status Messages window time-stamps all run time messages and displays them. You can do the
following:

Display Status: Enable/Disable status messages.

Auto Scroll: Scroll the status messages automatically.

Clear All: Clear all status messages in Status Window.

Save Status: Save all status messages in text file. Displays a standard save file window and saves the
status messages in the user specified file.
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View the Report
After the analysis, a report is automatically generated and displayed in the report panel. The device
information such as oscilloscope model, serial number, firmware version of the oscilloscope, version
information of the TekExpress and the application, start time, and the execution time are displayed.

A table shows the test name, measurement details, test result (pass/fail), compliance mode, and analysis
time. Save the report as an MHT file using the File > Save As option.

NOTE. If you use a secondary monitor, verify that the screen resolution of the secondary monitor is the
same as that of the primary display. This ensures that captured images in the reports are of the same size.
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View Test Related Files
All the test related files for currently selected tests are always saved under: My Documents\My

TekExpress\D-PHY\SessionName.

Case 1. An example image of data when the session is still not saved and is in the My TekExpress/D–PHY

path as “Untitled Session”, the DUT ID is set to DUT001, and the tests are performed twice (two
folders are created with the file naming convention YYYYMMDD_HHMMSS (Date_Time).

Case 2. An example image of data when the session is still not saved and is in the My TekExpress/D-PHY

path as “Untitled Session”, the DUT001 folder already present (tests are performed twice), and the
DUT ID is now set to DUT002 (here the tests are performed once).

Case 3. An example image of data when the session is saved and is in the My TekExpress/D-PHY

path as “Test”.
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Connection Setup
You need the following equipment (see Compatibility (see page 3)):

A supported Tektronix DPO oscilloscope

Single-ended probe

Differential probe

Device under test

Make connections as follows for single-ended tests:
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Make connections as follows for differential tests:

Configuring Parameter Values
To configure a test, do the following:

1. In the Select panel click Configure.

2. In the Configure panel, set the following general parameters that are common for all tests:

Parameter Value
Real Time Scope Select the oscilloscope to which to connect.
Measurement Method Select the measurement method: Automatic or Manual.

NOTE. The Manual method is available only when in the User
Defined mode.
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Filter File 1 (for testing in temperature chamber) Select the filter file to use for temperature chamber testing. Click on
the browse button in the field and select a file. If you select None, no
filter file is used (testing in temperature chamber is not considered).

NOTE. Filter file selection is available only in the User Defined mode.
Filter File 2 (for testing in temperature chamber
with Differential Probing)

Select the filter file to use with differential probing for temperature
chamber testing. Click on the browse button in the field and select a
file. If you select None, no filter file is used (testing in temperature
chamber is not considered).

NOTE. Filter file selection is available only in the User Defined mode.
xxx

The Automatic measurement method mode, lets you perform a test without any intervention. You
must select one or more tests, configure the tests (or use the default values) and click Run to perform
the test. The application acquires and analyzes the data, and displays a report when complete.

If you select the Manual mode, select one or more tests, configure the tests (or use the default values)
and click Run to perform the test. The application begins to acquire data. A window opens where
you are prompted to place the cursors on the acquired waveform and click OK. Go to the TekScope
application and zoom the waveform around the trigger point. Place the cursors on the waveform to
capture the values at those points and click OK in the window. The application completes the test
and displays the report.

For temperature chamber testing, a filter file with S4 parameters is used to compensate the factors
introduced due to length of the probe cable when testing the DUT in temperature chamber. You will
need one or two filter files based on the selected clock probing. If you select Single-ended probing,
you must specify only one filter file (Filter File 1). The application ignores the Filter File 2 even if
you provide it. If you select Differential probing, then you must specify both the filter files (Filter
File 1 and Filter File 2).

NOTE. Other applications will display there windows in the background. The TekScope application takes
precedence over other applications. Use Alt+Tab to view the other application windows.

3. Select either Compliance Mode or User Defined Mode. In the User Defined Mode, you can modify
the test parameters but you will no longer be testing against the compliance standards.

Temperature Chamber Testing
The TekExpress D-PHY offers the temperature chamber testing which is done at system level when the
device is put in the oven and the connection points from the DUT are extended to the probe using a wire.
This wire is 60” (5 ft) long and the signal must be de-embedded for the measurement. Filter files are
needed to offset the cable effects that are introduced in temperature chamber testing.

The setup shown below is expected to be done by the user. The DUT is ideally placed in an environment in
which the temperature can be externally controlled, which we call the Temperature Oven. The DUT is
then connected to the setup using the above-mentioned long cables that come from within the oven to
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the Tektronix P7500 series probes that are then connected to the desired channels of the Tektronix real
time scope.

However, the P7500 probe does not support LP measurement but can support all measurements in normal
mode. All the measurements that can be performed using the LP-HS transition mode are supported in
Temperature chamber mode.

The next specifies how to control this testing through the application once the setup is ready.

Steps for Performing Temperature Chamber Testing
The application provides a set of filter files. However, you have the option of selecting your own set of
filter files.

Temperature chamber testing is available only in the User Defined mode.

1. Select the test and click Configure.

2. Select the User Defined mode.
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3. Select Filter File1 by browsing to the folder.

4. Select Filter File 2 to use with differential probing for temperature chamber testing by browsing to
the folder.

You will need one or two filter files based on the selected clock probing. If you select Single-ended
probing, you must specify only one filter file (Filter File 1). If you select Differential probing, then you
must specify both the filter files (Filter File 1 and Filter File 2).

The filter file for each of the combinations is listed in the table

Table 8: Filter file names
Selection Affected channels/Lanes File name
NORMAL CLOCK, SINGLE ENDED Dp, Dn,Cp,Cn Single ended filter for all lanes
NORMAL CLOCK, DIFFERENTIAL Dp, Dn,Cp-n Single ended for Data lane, Differential

filter for clock lane
CONTINUOUS CLOCK, SINGLE
ENDED

Dp, Dn,Cp, Cn Single ended filter for all lanes

CONTINUOUS CLOCK,
DIFFERENTIAL

Dp, Dn,Cp-n Single ended for Data lane, Differential
filter for clock lane

xxx
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Logic Flow of Temperature Chamber Testing in TekExpress D-PHY
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Connections for Data Lane LP-TX Thevenin Output High Level Voltage
(VOH)

Click here for information on connections for the Data Lane LP-TX Thevenin Output High Level Voltage
(VOH) test.

Configure and Run Data Lane LP-TX Thevenin Output High Level
Voltage (VOH)

1. In the Select panel, select the Device.

NOTE. The Data Lane LP-TX Thevenin Output High Level Voltage (VOH) test is not available when the
selected clock lane probing is Differential.

You can also perform Data Lane LP related measurements on a signal that has an LP-HS transition.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type (Two Channel with Data
as Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 9: Configuration parameters for Data Lane LP-TX Thevenin Output High Level Voltage (VOH)
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
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Table 9: Configuration parameters for Data Lane LP-TX Thevenin Output High Level Voltage (VOH) (cont.)

Parameter Default User defined mode
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 10: Analysis parameters for Data Lane LP-TX Thevenin Output High Level Voltage (VOH)
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane LP-TX Thevenin Output High Voltage DP and Data
Lane LP-TX Thevenin Output High Voltage DN values, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to accept the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane LP-TX Thevenin Output Low Level Voltage
(VOL)

Click here for information on connections for the Data Lane LP-TX Thevenin Output Low Level Voltage
(VOL) test.

Configure and Run Data Lane LP-TX Thevenin Output Low Level Voltage
(VOL)

1. In the Select panel, select the Device.
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NOTE. The Data Lane LP-TX Thevenin Output Low Level Voltage (VOL) test is not available when the
selected clock lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type Two Channel with Data
as Trigger. The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 11: Configuration parameters for Data Lane LP-TX Thevenin Output Low Level Voltage (VOL)
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 12: Analysis parameters for Data Lane LP-TX Thevenin Output Low Level Voltage (VOL)
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx
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8. Click Limits to view and change the Data Lane LP-TX Thevenin Output Low Voltage DP and Data
Lane LP-TX Thevenin Output Low Voltage DN values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane Rise Time
Click here for information on connections for the Data Lane Rise Time test.

Configure and Run Data Lane Rise Time
1. In the Select panel, select the Device.

NOTE. The Data Lane Rise Time test is not available when the selected clock lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type Two Channel with Data
as Trigger. The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 13: Configuration parameters for Data Lane Rise Time
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
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Table 13: Configuration parameters for Data Lane Rise Time (cont.)

Parameter Default User defined mode
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 14: Analysis parameters for Data Lane Rise Time
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane Rise Time DP and Data Lane Rise Time DN values in
nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane Fall Time
Click here for information on connections for the Data Lane Fall Time test.

Configure and Run Data Lane Fall Time
1. In the Select panel, select the Device.
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NOTE. The Data Lane Fall Time test is not available when the selected clock lane probing is Differential.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Escape.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type Two Channel with Data
as Trigger. The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 15: Configuration parameters for Data Lane Fall Time
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 16: Analysis parameters for Data Lane Fall Time
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane Fall Time DP and Data Lane Fall Time DN values in
nS, and the compare string.
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9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

View Report for Group 1 Tests
The application automatically displays a report in the Report panel once the test is successfully completed.
A table shows the test name, measurement details, test result (pass/fail), compliance mode, and analysis
time. Save the report as an MHT file using the File > Save As option. The following screen shows
the results for Group 1 tests.
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Connections for Clock Lane LP-TX Thevenin Output High Level Voltage
(VOH)

Click here for information on connections for the Clock Lane LP-TX Thevenin Output High Level Voltage
(VOH) test.

Configure and Run Clock Lane LP-TX Thevenin Output High Level
Voltage (VOH)

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane LP-TX Thevenin Output High Level Voltage (VOH) test is not available when the
selected clock lane probing is Differential.

You can also perform Clock LP mode measurements using LP-HS transition.

4. Select the Test Mode as Escape.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type Two Channel with
Clock/Data as Trigger. The following table lists the compliance mode values and the permitted range
of values for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 17: Configuration parameters for Clock Lane LP-TX Thevenin Output High Level Voltage (VOH)
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
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Table 17: Configuration parameters for Clock Lane LP-TX Thevenin Output High Level Voltage (VOH) (cont.)

Parameter Default User defined mode
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 18: Analysis parameters for Clock Lane LP-TX Thevenin Output High Level Voltage (VOH)
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0,05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Clock Lane LP-TX Thevenin Output High Voltage CP and Clock
Lane LP-TX Thevenin Output High Voltage CN values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Clock Lane LP-TX Thevenin Output Low Level Voltage
(VOL)

Click here for information on connections for the Clock Lane LP-TX Thevenin Output Low Level Voltage
(VOL) test.

Configure and Run Clock Lane LP-TX Thevenin Output Low Level
Voltage (VOL)

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL) test is not available when the
selected clock lane probing is Differential.

4. Select the Test Mode as Escape.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type Two Channel with Clock
as Trigger. The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 19: Configuration parameters for Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL)
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx
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7. Click Analyze. View and change the following analysis parameters:

Table 20: Analysis parameters for Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL)
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Clock Lane LP-TX Thevenin Output Low Voltage CP and Clock
Lane LP-TX Thevenin Output Low Voltage CN values, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane Rise Time
Click here for information on connections for the Clock Lane Rise Time test.

Configure and Run Clock Lane Rise Time
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane Rise Time test is not available when the selected clock lane probing is Differential.

4. Select the Test Mode as Escape.
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The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type Two Channel with Clock
as Trigger. The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 21: Configuration parameters for Clock Lane Rise Time
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 22: Analysis parameters for Clock Lane Rise Time
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Clock Lane Rise Time CP and Clock Lane Rise Time CN values
in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

TekExpress D-PHY Automated Solution 57



Application Examples Connections for Clock Lane Fall Time

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Connections for Clock Lane Fall Time
Click here for information on connections for the Clock Lane Rise Time test.

Configure and Run Clock Lane Fall Time
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane Fall Time test is not available when the selected clock lane probing is Differential.

4. Select the Test Mode as Escape.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the acquire type Two Channel with Clock
as Trigger. The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 23: Configuration parameters for Clock Lane Fall Time
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx
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7. Click Analyze. View and change the following analysis parameters:

Table 24: Analysis parameters for Clock Lane Fall Time
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Clock Lane Fall Time CP and Clock Lane Fall Time CN values
in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

View Report for Group 2 Tests
The application automatically displays a report in the Report panel once the test is successfully completed.
A table shows the test name, measurement details, test result (pass/fail), compliance mode, and analysis
time. Save the report as an MHT file using the File > Save As option. The following screen shows
the results for Group 2 tests.
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Connections for Data Lane HS Entry: Data Lane TLPX Value
Click here for information on connections for the Data Lane HS Entry: Data Lane TLPX Value test.

Configure and Run Data Lane HS Entry: Data Lane TLPX Value
The Data Lane HS Entry: Data Lane TLPX Value test is supported on LP-HS waveforms although it is not
recommended to use LP-HS waveforms for this test.

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

NOTE. The Clock mode Continuous is available only when the test mode is Normal.

3. Select Clock Lane Probing as Single-ended.
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NOTE. The Data Lane HS Entry: Data Lane TLPX Value test is not available when the selected clock
lane probing is Differential.

4. Select the Test Mode as Escape or Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test. The following table lists the
compliance mode values and the permitted range of values for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 25: Configuration parameters for Data Lane HS Entry: Data Lane TLPX Value
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 26: Analysis parameters for Data Lane HS Entry: Data Lane TLPX Value
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane HS Entry DATA Lane TLP value and the compare
string.

9. Click Comments to enter comments. The comments are shown in the test report.
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10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane HS Entry: THS-PREPARE Value
Click here for information on connections for the Data Lane HS Entry: THS-PREPARE Value test.

Configure and Run Data Lane HS Entry: THS-PREPARE Value
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel wit Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 27: Configuration parameters for Data Lane HS Entry: THS-PREPARE Value
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

–3 to +3
+3 to –3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx
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7. Click Analyze. View and change the following analysis parameters:

Table 28: Analysis parameters for Data Lane HS Entry: THS-PREPARE Value
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane HS Entry: THS-PREPARE values in ns, and the
compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane HS Entry: THS-PREPARE + THS-ZERO Value
Click here for information on connections for the Data Lane HS Entry: THS-PREPARE + THS-ZERO
Value test.

Configure and Run Data Lane HS Entry: THS-PREPARE + THS-ZERO
Value

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.
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6. In the Configuration Panel, set the following parameters for the test (Four Channel wit Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 29: Configuration parameters for Data Lane HS Entry: THS-PREPARE + THS-ZERO
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

–3 to +3
–3 to –3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 30: Analysis parameters for Data Lane HS Entry: THS-PREPARE + THS-ZERO
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane HS Entry: THS-PREPARE + THS-ZERO values in
ns, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Data Lane HS-TX Differential Voltages (VOD(0), VOD(1))
Click here for information on connections for the Data Lane HS-TX Differential Voltages (VOD(0),
VOD(1)) Value test.

Configure and Run Data Lane HS-TX Differential Voltages (VOD(0),
VOD(1))

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 31: Configuration parameters for Data Lane HS-TX Differential Voltages (VOD(0), VOD(1))
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 32: Analysis parameters for Data Lane HS-TX Differential Voltages (VOD(0), VOD(1))
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
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Table 32: Analysis parameters for Data Lane HS-TX Differential Voltages (VOD(0), VOD(1)) (cont.)

Parameter Default User defined mode
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the VOD(1) and VOD(0) values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane HS-TX Differential Voltage Mismatch (VOD)
Click here for information on connections for the Data Lane HS-TX Differential Voltage Mismatch
(VOD) Value test.

Configure and Run Data Lane HS-TX Differential Voltage Mismatch (VOD)
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 33: Configuration parameters for Data Lane HS-TX Differential Voltage Mismatch (VOD)
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
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Table 33: Configuration parameters for Data Lane HS-TX Differential Voltage Mismatch (VOD) (cont.)

Parameter Default User defined mode
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

+2.6 –3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 34: Analysis parameters for Data Lane HS-TX Differential Voltage Mismatch (VOD)
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the VOD values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Data Lane HS-TX Single-Ended Output High Voltages
((VOHHS(DP), VOHHS(DN))

Click here for information on connections for the Data Lane HS-TX Single-Ended Output High Voltages
((VOHHS(DP), VOHHS(DN)) test.

Configure and Run Data Lane HS-TX Single-Ended Output High Voltages
((VOHHS(DP), VOHHS(DN))

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 35: Configuration parameters for Data Lane HS-TX Single-Ended Output High Voltages ((VOHHS(DP),
VOHHS(DN))
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 36: Analysis parameters for Data Lane HS-TX Single-Ended Output High Voltages ((VOHHS(DP),
VOHHS(DN))
Parameter Default User defined mode
Trigger Type Transition Transition
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Table 36: Analysis parameters for Data Lane HS-TX Single-Ended Output High Voltages ((VOHHS(DP),
VOHHS(DN)) (cont.)

Parameter Default User defined mode
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane HS-TX Single-Ended Output High Voltages DP
and DN values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane HS-TX Static Common-Mode Voltages
(VCMTX(1), VCMTX(0))

Click here for information on connections for the Data Lane HS-TX Static Common-Mode Voltages
(VCMTX(1), VCMTX(0)) test.

Configure and Run Data Lane HS-TX Static Common-Mode Voltages
(VCMTX(1), VCMTX(0))

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.
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6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 37: Configuration parameters for Data Lane HS-TX Static Common-Mode Voltages (VCMTX(1),
VCMTX(0))
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 38: Analysis parameters for Data Lane HS-TX Static Common-Mode Voltages (VCMTX(1), VCMTX(0))
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Common Mode Voltages VTX(0) and VTX(1) values in mV,
and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Data Lane HS-TX Static Common-Mode Voltage
Mismatch (VCMTX(1,0))

Click here for information on connections for the Data Lane HS-TX Static Common-Mode Voltage
Mismatch (VCMTX(1,0)) test

Configure and Run Data Lane HS-TX Static Common-Mode Voltage
Mismatch (VCMTX(1,0))

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 39: Configuration parameters for Data Lane HS-TX Static Common-Mode Voltage Mismatch (VCMTX(1,0))
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 40: Analysis parameters for Data Lane HS-TX Static Common-Mode Voltage Mismatch (VCMTX(1,0))
Parameter Default User defined mode
Trigger Type Transition Transition
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Table 40: Analysis parameters for Data Lane HS-TX Static Common-Mode Voltage Mismatch (VCMTX(1,0))
(cont.)

Parameter Default User defined mode
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Common Mode Voltage Mismatch values in mV, and the
compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane HS-TX Dynamic Common-Level Variations
Between 50-450MHz (VCMTX(LF))

Click here for information on connections for the Data Lane HS-TX Dynamic Common-Level Variations
Between 50-450MHz (VCMTX(LF)) test

Configure and Run Data Lane HS-TX Dynamic Common-Level Variations
Between 50-450MHz (VCMTX(LF))

The Data Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz (VCMTX(LF)) test
uses a band pass filter. To perform the measurement, the application uses both the original waveform
(unfiltered) and the filtered waveform as follows:

1. Acquires unfiltered waveforms from the oscilloscope channels. Typical unfiltered
waveform names are like Acq4TwoChannelwithClockasTrigger_CN.WFM and
Acq4TwoChannelwithClockasTrigger_CP.WFM.

2. Applies a band pass filter on live channels and stores them on the Math channel. The band pass filter
files that the application uses are TwoChannelwithDataasTriggerAndBandPassFilter_DP.WFM
and TwoChannelwithDataasTriggerAndBandPassFilter_DN.WFM. Typical filtered waveform
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file name are like TwoChannelwithClockasTriggerAndBandPassFilter_CP.WFM and
TwoChannelwithClockasTriggerAndBandPassFilter_CN.WFM.

3. Saves both Live and Math waveforms to the disk.

4. Performs the measurement using both the Live and Math waveforms.

In the pre-recorded mode, it is enough if you to select the unfiltered waveforms. However, make sure
that the filtered waveforms are in the same folder as the unfiltered waveforms for these measurements
to run correctly in pre-recorded mode. The filtered waveforms for the measurements must be the ones
saved by the TekExpress application. The measurements will not work as expected if any other filtered
waveforms are used. .

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger and BandPass). The following table lists the compliance mode values and the permitted range
of values for the user-defined mode:

Table 41: Configuration parameters for Data Lane HS-TX Dynamic Common-Level Variations Between
50-450MHz (VCMTX(LF))
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 42: Analysis parameters for Data Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz
(VCMTX(LF))
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
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Table 42: Analysis parameters for Data Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz
(VCMTX(LF)) (cont.)

Parameter Default User defined mode
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane HS-TX Dynamic Common-Level Variations value in
mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane HS-TX Dynamic Common-Level Variations
Above 450MHz (VCMTX(HF))

Click here for information on connections for the Data Lane HS-TX Dynamic Common-Level Variations
Above 450MHz (VCMTX(HF)) test

Configure and Run Data Lane HS-TX Dynamic Common-Level Variations
Above 450MHz (VCMTX(HF))

The Data Lane HS-TX Dynamic Common-Level Variations Above 450MHz (VCMTX(LF)) test uses a
high pass filter. To perform the measurement, the application uses both the original waveform (unfiltered)
and the filtered waveform as follows:

1. Acquires unfiltered waveforms from the oscilloscope channels. Typical unfiltered
waveform names are like Acq4TwoChannelwithClockasTrigger_CN.WFM and
Acq4TwoChannelwithClockasTrigger_CP.WFM.

2. Applies a high pass filter on live channels and stores them on the Math channel. The high pass filter
files that the application uses are TwoChannelwithDataasTriggerAndHighPassFilter_DP.WFM
and TwoChannelwithDataasTriggerAndHighPassFilter_DN.WFM.
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3. Saves both Live and Math waveforms to the disk.

4. Performs the measurement using both the Live and Math waveforms.

In the pre-recorded mode, it is enough if you to select the unfiltered waveforms. However, make sure
that the filtered waveforms are in the same folder as the unfiltered waveforms for these measurements
to run correctly in pre-recorded mode. The filtered waveforms for the measurements must be the ones
saved by the TekExpress application. The measurements will not work as expected if any other filtered
waveforms are used. .

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger and HighPass). The following table lists the compliance mode values and the permitted range
of values for the user-defined mode:

Table 43: Configuration parameters for Data Lane HS-TX Dynamic Common-Level Variations Above 450MHz
(VCMTX(HF))
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 44: Analysis parameters for Data Lane HS-TX Dynamic Common-Level Variations Above 450MHz
(VCMTX(HF))
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
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Table 44: Analysis parameters for Data Lane HS-TX Dynamic Common-Level Variations Above 450MHz
(VCMTX(HF)) (cont.)

Parameter Default User defined mode
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Negative Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane HS-TX Dynamic Common-Level Variations value in
mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane HS-TX 20%-80% Rise time (tR)
Click here for information on connections for the Data Lane HS-TX 20%-80% Rise time (tR) test.

Configure and Run Data Lane HS-TX 20%-80% Rise time (tR)
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 45: Configuration parameters for Data Lane HS-TX 20%-80% Rise time (tR)
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
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Table 45: Configuration parameters for Data Lane HS-TX 20%-80% Rise time (tR) (cont.)

Parameter Default User defined mode
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 46: Analysis parameters for Data Lane HS-TX 20%-80% Rise time (tR)
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the tR value in pS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Data Lane HS-TX 80%-20% Fall time (tF)
Click here for information on connections for the Data Lane HS-TX 80%-20% Fall time (tF) test.

Configure and Run Data Lane HS-TX 80%-20% Fall time (tF)
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 47: Configuration parameters for Data Lane HS-TX 80%-20% Fall time (tF)
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 48: Analysis parameters for Data Lane HS-TX 80%-20% Fall time (tF)
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
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Table 48: Analysis parameters for Data Lane HS-TX 80%-20% Fall time (tF) (cont.)

Parameter Default User defined mode
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the tF values in pS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Data Lane HS Exit: THS-TRAIL Value
Click here for information on connections for the Data Lane HS Exit: THS-TRAIL Value test.

Configure and Run Data Lane HS Exit: THS-TRAIL Value
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 49: Configuration parameters for Data Lane HS Exit: THS-TRAIL Value
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3
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Table 49: Configuration parameters for Data Lane HS Exit: THS-TRAIL Value (cont.)

Parameter Default User defined mode
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 50: Analysis parameters for Data Lane HS Exit: THS-TRAIL Value
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane THS-TRAIL values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Data Lane HS Exit: 30%-80% Post-EOT Rise Test
(TREOT)

Click here for information on connections for the Data Lane HS Exit: 30%–80% Post-EOT Rise Test
(TREOT) test.

Configure and Run Data Lane HS Exit: 30%-80% Post-EOT Rise Test
(TREOT)

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Data as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 51: Configuration parameters for Data Lane HS Exit: 30%-80% Post-EOT Rise Test (TREOT)
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 52: Analysis parameters for Data Lane HS Exit: 30%-80% Post-EOT Rise Test (TREOT)
Parameter Default User defined mode
Trigger Type Transition Transition
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Table 52: Analysis parameters for Data Lane HS Exit: 30%-80% Post-EOT Rise Test (TREOT) (cont.)

Parameter Default User defined mode
Trigger Source Ch1 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Data Lane TREOT value in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

View Report for Group 3 Tests
The application automatically displays a report in the Report panel once the test is successfully completed.
A table shows the test name, measurement details, test result (pass/fail), compliance mode, and analysis
time. Save the report as an MHT file using the File > Save As option. The following screen shows
the results for Group 3 tests.
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Connections for Clock Lane HS Entry TLPX Value
Single-ended clock signal only

Click here for information on connections for the Clock Lane HS Entry TLPX Value test.

Configure and Run Clock Lane HS Entry TLPX Value
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

NOTE. This test is not available in the Continuous Clock mode.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.
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The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 53: Configuration parameters for Clock Lane HS Entry TLPX Value
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 54: Analysis parameters for Clock Lane HS Entry TLPX Value
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Clock Lane HS Entry TLPX Value in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Clock Lane HS Entry TCLK-PREPARE Value
test id 1.4.2.

Single-ended clock signal only

Click here for information on connections for the Clock Lane HS Entry TCLK-PREPARE Value test.

Configure and Run Clock Lane HS Entry TCLK-PREPARE Value
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

NOTE. This test is not available in the Continuous Clock mode.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 55: Configuration parameters for Clock Lane HS Entry TCLK-PREPARE Value
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (ns) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:
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Table 56: Analysis parameters for Clock Lane HS Entry TCLK-PREPARE Value
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Clock Lane HS Entry TCLK-PREPARE Value in nS, and the
compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO
Value

Click here for information on connections for the Clock Lane HS Entry TCLK-PREPARE Value test.

Configure and Run Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO
Value

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

NOTE. This test is not available in the Continuous Clock mode.

3. Select Clock Lane Probing as Single-ended.
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NOTE. The Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO Value is not available in the Differential
Mode.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 57: Configuration parameters for Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO Value
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (ns) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 58: Analysis parameters for Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO Value
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Clock Lane HS Entry TCLK-PREPARE Value in nS, and the
compare string.
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9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS-TX Differential Voltages (VOD(0),
VOD(1))

Click here for information on connections for the Clock Lane HS-TX Differential Voltages (VOD(0),
VOD(1)) test.

Configure and Run Clock Lane HS-TX Differential Voltages (VOD(0),
VOD(1))

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 59: Configuration parameters for Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1))
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx
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7. Click Analyze. View and change the following analysis parameters:

Table 60: Analysis parameters for Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1))
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge

Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1

Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx

8. Click Limits to view and change the Clock Lane VOD(1) and VOD(2) values in mV, and the compare
string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Clock Lane HS-TX Differential Voltage Mismatch
Click here for information on connections for the Clock Lane HS-TX Differential Voltages (VOD(0),
VOD(1)) test.

Configure and Run Clock Lane HS-TX Differential Voltage Mismatch
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 61: Configuration parameters for Clock Lane HS-TX Differential Voltage Mismatch
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 62: Analysis parameters for Clock Lane HS-TX Differential Voltage Mismatch
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge

Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
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Table 62: Analysis parameters for Clock Lane HS-TX Differential Voltage Mismatch (cont.)

Parameter Default User defined mode
Trigger Upper Level (V)

Single-ended probing
Differential probing

1
0.15

Enter a value based on the test

Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1

Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx

8. Click Limits to view and change the Clock Lane VOD value in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Clock Lane HS-TX Single-Ended Output High Voltages
(VOHHS(DP), VOHHS(DN))

Click here for information on connections for the Clock Lane HS-TX Single-Ended Output High Voltages
(VOHHS(DP), VOHHS(DN)) test.

Configure and Run Clock Lane HS-TX Single-Ended Output High
Voltages (VOHHS(DP), VOHHS(DN))

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 63: Configuration parameters for Clock Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP),
VOHHS(DN))
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 64: Analysis parameters for Clock Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP),
VOHHS(DN))
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge
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Table 64: Analysis parameters for Clock Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP),
VOHHS(DN)) (cont.)

Parameter Default User defined mode
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx

8. Click Limits to view and change the Clock Lane HS-TX Single-Ended Output High Voltages DP
and DN values in mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS-TX Static Common-Mode Voltages
(VCMTX(1), VCMTX(0))

Click here for information on connections for the Clock Lane HS-TX Static Common-Mode Voltages
(VCMTX(1), VCMTX(0)) test.

Configure and Run Clock Lane HS-TX Static Common-Mode Voltages
(VCMTX(1), VCMTX(0))

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.
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NOTE. The Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1), VCMTX(0)) test is not
available when the selected clock lane probing is Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 65: Configuration parameters for Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1),
VCMTX(0))
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 66: Analysis parameters for Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1), VCMTX(0))
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge

Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx
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8. Click Limits to view and change the Common Mode Voltages VTX(0) and VTX(1) values in mV,
and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS-TX Static Common-Mode Voltage
Mismatch (VCMTX(1,0))

Click here for information on connections for the Clock Lane HS-TX Static Common-Mode Voltage
Mismatch (VCMTX(1,0)) test

Configure and Run Clock Lane HS-TX Static Common-Mode Voltage
Mismatch (VCMTX(1,0))

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane HS-TX Static Common-Mode Voltage Mismatch (VCMTX(1, 0)) test is not
available when the selected clock lane probing is Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 67: Configuration parameters for Clock Lane HS-TX Static Common-Mode Voltage Mismatch
(VCMTX(1,0))
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
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Table 67: Configuration parameters for Clock Lane HS-TX Static Common-Mode Voltage Mismatch
(VCMTX(1,0)) (cont.)

Parameter Default User defined mode
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 68: Analysis parameters for Clock Lane HS-TX Static Common-Mode Voltage Mismatch (VCMTX(1,0))
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge

Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx

8. Click Limits to view and change the Common Mode Voltage Mismatch values in mV, and the
compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Clock Lane HS-TX Dynamic Common-Level Variations
Between 50-450MHz (VCMTX(LF))

Click here for information on connections for the Clock Lane HS-TX Dynamic Common-Level Variations
Between 50-450MHz (VCMTX(LF)) test

Configure and Run Clock Lane HS-TX Dynamic Common-Level
Variations Between 50-450MHz (VCMTX(LF))

The Clock Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz (VCMTX(LF)) test
uses a band pass filter. To perform the measurement, the application uses both the original waveform
(unfiltered) and the filtered waveform as follows:

1. Acquires unfiltered waveforms from the oscilloscope channels. Typical unfiltered
waveform names are like Acq4TwoChannelwithClockasTrigger_CN.WFM and
Acq4TwoChannelwithClockasTrigger_CP.WFM.

2. Applies a band pass filter on live channels and stores them on theMath channel. The band pass filter files
that the application uses are TwoChannelwithClockasTriggerAndBandPassFilter_CP.WFM
and TwoChannelwithClockasTriggerAndBandPassFilter_CN.WFM. Typical filtered waveform
file name are like TwoChannelwithClockasTriggerAndBandPassFilter_CP.WFM and
TwoChannelwithClockasTriggerAndBandPassFilter_CN.WFM.

3. Saves both Live and Math waveforms to the disk.

4. Performs the measurement using both the Live and Math waveforms.

In the pre-recorded mode, it is enough if you to select the unfiltered waveforms. However, make sure
that the filtered waveforms are in the same folder as the unfiltered waveforms for these measurements
to run correctly in pre-recorded mode. The filtered waveforms for the measurements must be the ones
saved by the TekExpress application. The measurements will not work as expected if any other filtered
waveforms are used. .

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz (VCMTX(LF))
test is not available when the selected clock lane probing is Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).
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5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger and BandPass). The following table lists the compliance mode values and the permitted range
of values for the user-defined mode:

Table 69: Configuration parameters for Clock Lane HS-TX Dynamic Common-Level Variations Between
50-450MHz (VCMTX(LF))
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 70: Analysis parameters for Clock Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz
(VCMTX(LF))
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge

Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx

8. Click Limits to view and change the Clock Lane HS-TX Dynamic Common-Level Variations value in
mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.
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11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS-TX Dynamic Common-Level Variations
Above 450MHz (VCMTX(HF))

Click here for information on connections for the Clock Lane HS-TX Dynamic Common-Level Variations
Above 450MHz (VCMTX(HF)) test

Configure and Run Clock Lane HS-TX Dynamic Common-Level
Variations Above 450MHz (VCMTX(HF))

The Clock Lane HS-TX Dynamic Common-Level Variations Above 450MHz (VCMTX(HF)) test uses a
high pass filter. To perform the measurement, the application uses both the original waveform (unfiltered)
and the filtered waveform as follows:

1. Acquires unfiltered waveforms from the oscilloscope channels. Typical unfiltered
waveform names are like Acq4TwoChannelwithClockasTrigger_CN.WFM and
Acq4TwoChannelwithClockasTrigger_CP.WFM.

2. Applies a high pass filter on live channels and stores them on the Math channel. The high pass filter files
that the application uses are TwoChannelwithClockasTriggerAndHighPassFilter_CP.WFM
and TwoChannelwithClockasTriggerAndHighPassFilter_CN.WFM.

3. Saves both Live and Math waveforms to the disk.

4. Performs the measurement using both the Live and Math waveforms.

In the pre-recorded mode, it is enough if you to select the unfiltered waveforms. However, make sure
that the filtered waveforms are in the same folder as the unfiltered waveforms for these measurements
to run correctly in pre-recorded mode. The filtered waveforms for the measurements must be the ones
saved by the TekExpress application. The measurements will not work as expected if any other filtered
waveforms are used. .

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended.

NOTE. The Clock Lane HS-TX Dynamic Common-Level Variations Above 450MHz (VCMTX(HF)) test is
not available when the selected clock lane probing is Differential.

4. Select the Test Mode as Normal.
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The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger and HighPass). The following table lists the compliance mode values and the permitted range
of values for the user-defined mode:

Table 71: Configuration parameters for Clock Lane HS-TX Dynamic Common-Level Variations Above 450MHz
(VCMTX(HF))
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 72: Analysis parameters for Clock Lane HS-TX Dynamic Common-Level Variations Above 450MHz
(VCMTX(HF))
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge

Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx

8. Click Limits to view and change the Clock Lane HS-TX Dynamic Common-Level Variations value in
mV, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or click Cancel.
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11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS-TX 20%-80% Rise time (tR)
Click here for information on connections for the Clock Lane HS-TX 20%-80% Rise time (tR) test.

Configure and Run Clock Lane HS-TX 20%-80% Rise time (tR)
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 73: Configuration parameters for Clock Lane HS-TX 20%-80% Rise time (tR)
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 74: Analysis parameters for Clock Lane HS-TX 20%-80% Rise time (tR)
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge
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Table 74: Analysis parameters for Clock Lane HS-TX 20%-80% Rise time (tR) (cont.)

Parameter Default User defined mode
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1

Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx

8. Click Limits to view and change the tR value in pS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS-TX 80%-20% Fall time (tF)
Click here for information on connections for the Clock Lane HS-TX 80%-20% Fall time (tF) test.

Configure and Run Clock Lane HS-TX 80%-20% Fall time (tF)
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.
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The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 75: Configuration parameters for Clock Lane HS-TX 80%-20% Fall time (tF)
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 76: Analysis parameters for Clock Lane HS-TX 80%-20% Fall time (tF)
Parameter Default User defined mode
Trigger Type

Normal Clock
Continuous Clock

Transition
Edge

Transition
Edge

Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1

Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Normal Clock
Continuous Clock

Greater Than
Not Applicable

Greater Than, Less Than
Not Applicable

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Normal Clock
Continuous Clock

Occurs
Not Applicable

Occurs, Logic
Not Applicable

xxx

8. Click Limits to view and change the tF values in pS, and the compare string.
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9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS Exit: TCLK-TRAIL Value
Click here for information on connections for the Clock Lane HS Exit: TCLK-TRAIL Value test.

Configure and Run Clock Lane HS Exit: TCLK-TRAIL Value
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal .

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 77: Configuration parameters for Clock Lane HS Exit: TCLK-TRAIL Value
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 78: Analysis parameters for Clock Lane HS Exit: TCLK-TRAIL Value
Parameter Default User defined mode
Trigger Type Transition Transition
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Table 78: Analysis parameters for Clock Lane HS Exit: TCLK-TRAIL Value (cont.)

Parameter Default User defined mode
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs
xxx

8. Click Limits to view and change the Clock Lane THS-TRAIL values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Lane HS Exit: 30%-85% Post-EoT Rise Time
(TREOT)

Click here for information on connections for the Clock Lane HS Exit: 30%–85% Post-EoT Rise Time
(TREOT) test.

Configure and Run Clock Lane HS Exit: 30%-85% Post-EoT Rise Time
(TREOT)

1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal.

3. Select Clock Lane Probing as Single-ended.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.
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6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 79: Configuration parameters for Clock Lane HS Exit: 30%-85% Post-EoT Rise Time (TREOT)
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 80: Analysis parameters for Clock Lane HS Exit: 30%-85% Post-EoT Rise Time (TREOT)
Parameter Default User defined mode
Trigger Type Transition, Edge Transition, Edge
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the Clock Lane TREOT value in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for Clock Lane HS Clock Instantaneous (UIINST)
Click here for information on connections for the Clock Lane HS Clock Instantaneous (UIINST) test.

Configure and Run Clock Lane HS Clock Instantaneous (UIINST)
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal or Continuous.

3. Select Clock Lane Probing as Single-ended .

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Two Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 81: Configuration parameters for Clock Lane HS Clock Instantaneous (UIINST)
Parameter Default User defined mode
Vertical Scale (mV) 200 100, 200, 300
Vertical Position (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 82: Analysis parameters for Clock Lane HS Clock Instantaneous (UIINST)
Parameter Default User defined mode
UI INST MIN (nS) 1.25 Greater than or equal to 1.25

and less than or equal to 12.5
Trigger Type

Single-ended probing
Differential probing

Transition
Edge

Transition
Edge

Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
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Table 82: Analysis parameters for Clock Lane HS Clock Instantaneous (UIINST) (cont.)

Parameter Default User defined mode
Trigger Upper Level for
Differential (V)

-0.3 +1 to -1

Trigger Lower Level for
Differential (V)

-0.9 +1 to -1

Trigger Level for Clock
Continuous Mode (V)

0.2 0.2, 0.05, 0.1

Trigger Time (pS) 500 250, 500
Trigger Transition

Single-ended probing
Differential probing

Greater Than
NA

Greater Than, Less Than
NA

Trigger Slope Positive Positive, Negative, Either
Trigger If Violation

Single-ended probing
Differential probing

Occurs
NA

Occurs, Logic
NA

xxx

8. Click Limits to view and change the Maximum (UIINST) values in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or clickCancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

View Report for Group 4 Tests
The application automatically displays a report in the Report panel once the test is successfully completed.
A table shows the test name, measurement details, test result (pass/fail), compliance mode, and analysis
time. Save the report as an MHT file using the File > Save As option. The following screen shows
the results for Group 4 tests.
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Connections for HS Entry TCLK PREValue
Click here for information on connections for the HS Entry TCLK PREValue test.

Configure and Run HS Entry TCLK PREValue
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal .

NOTE. The HS Entry TCLK PREValue test is not available in the Clock Continuous Mode.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).
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5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 83: Configuration parameters for HS Entry TCLK PREValue
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 84: Analysis parameters for HS Entry TCLK PREValue
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the HS Entry TCLK PREValue in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.
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Connections for HS Exit TCLK POSTValue
Click here for information on connections for the HS Exit TCLK POSTValue test.

Configure and Run HS Entry TCLK POSTValue
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal .

NOTE. The HS Entry TCLK POSTValue test is not available in the Clock Continuous Mode.

3. Select Clock Lane Probing as Single-ended or Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.

6. In the Configuration Panel, set the following parameters for the test (Four Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

NOTE. The record length for this measurement can be a maximum of 5,000,000. The measurement may not
work properly with longer record lengths.

Table 85: Configuration parameters for HS Exit TCLK POSTValue
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div)

Single-ended probing
Differential probing

–2.6
+2.6

+3 to –3
–3 to +3

Vertical Offset (V) 0 Do not change
Horizontal Scale (ns) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

TekExpress D-PHY Automated Solution 111



Application Examples Connections for Clock Rising Edge Alignment to First Payload Bit

Table 86: Analysis parameters for HS Exit: TCLK-POST Value
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

8. Click Limits to view and change the HS Exit TCLK POSTValue in nS, and the compare string.

9. Click Comments to enter comments. The comments are shown in the test report.

10. Click Save to effect the changes, or click Cancel.

11. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.

12. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

Connections for Clock Rising Edge Alignment to First Payload Bit
Click here for information on connections for the Clock Rising Edge Alignment to First Payload Bit test.

Configure and Run Clock Rising Edge Alignment to First Payload Bit
1. In the Select panel, select the Device.

2. Select the Clock Mode as Normal .

3. Select Clock Lane Probing as Single-ended .

NOTE. The Clock Rising Edge Alignment to First Payload Bit test is not available when the selected clock
lane probing is Differential.

4. Select the Test Mode as Normal.

The Version default value is CTS 0.98 (Base Spec 1.0).

5. Select the test and click Configure.
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6. In the Configuration Panel, set the following parameters for the test (Four Channel with Clock as
Trigger). The following table lists the compliance mode values and the permitted range of values
for the user-defined mode:

Table 87: Configuration parameters for Clock Rising Edge Alignment to First Payload Bit
Parameter Default User defined mode
Vertical Scale (mV) 200 50, 100, 200
Vertical Position for Data (div) –2.6 +3 to –3
Vertical Position for Clock (div) –2.6 +3 to –3
Vertical Offset (V) 0 Do not change
Horizontal Scale (us) 8 8, 10, 12
Sample Rate (GS/s) 12.5 7.5, 10, 12.5
Record Length 1000000 100000 to 10000000
xxx

7. Click Analyze. View and change the following analysis parameters:

Table 88: Analysis parameters for Clock Rising Edge Alignment to First Payload Bit
Parameter Default User defined mode
Trigger Type Transition Transition
Trigger Source Ch3 Ch1, Ch2, Ch3, Ch4
Trigger Upper Level (V) 1 Enter a value based on the test
Trigger Lower Level (V) 0.05 0.05, 0.1, 1
Trigger Time (pS) 500 250, 500
Trigger Transition Greater Than Greater Than, Less Than
Trigger Slope Positive Positive, Negative, Either
Trigger If Violation Occurs Occurs, Logic
xxx

NOTE. The Limits tab has no configurable parameters.

8. Click Comments to enter comments. The comments are shown in the test report.

9. Click Save to effect the changes, or click Cancel.

10. Click the Acquire tab to view the acquisition parameters. Select the Data (Dp and Dn) and Clock
(Clkp and Clkn) sources.
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11. Click Run to start the test. The Acquire panel shows the progress and status of the test as it runs.

12. Follow the on-screen prompt and complete the test.

View Report for Group 5 Tests
The application automatically displays a report in the Report panel once the test is successfully completed.
A table shows the test name, measurement details, test result (pass/fail), compliance mode, and analysis
time. Save the report as an MHT file using the File > Save As option. The following screen shows
the results for Group 5 tests.
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About the Programmatic Interface
The Programmatic interface allows you to seamlessly integrate the TekExpress test automation application
with the high-level automation layer. This also allows you to control the state of TekExpress application
running on a local or a remote computer.

For simplifying the descriptions, the following terminologies are used in this section:

TekExpress Client: A High level automation application that communicates with TekExpress using
TekExpress Programmatic Interface.

TekExpress Server: The TekExpress application when being controlled by TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for TekExpress Client.
TekExpress provides a client library for TekExpress clients to use the programmatic interface. The
TekExpress client library is inherited from .Net MarshalByRef class to provide the proxy object for the
clients. The TekExpress client library maintains a reference to the TekExpress Server and this reference
allows the client to control the server state.

Click the following links to get details on them:

What does one need to have to develop TekExpress Client?

While developing TekExpress Client one needs to use the TekExpressClient.dll. The client can be a VB
.Net, C# .Net, TestStand or web application. The examples for interfaces in each of these applications
are in Samples folder.

References required
TekExpressClient.dll has internal reference to IIdlglib.dll and IRemoteInterface.dll.

IIdlglib.dll has a reference to TekDotNetLib.dll.

IRemoteInterface.dll provides the interfaces required to perform the remote automations. It is an interface
that forms the communication line between the server and the client.

IIdlglib.dll provides the methods to generate and direct the secondary dialog messages at the client-end.
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NOTE. The end-user client application does not need any reference to above mentioned DLL files. It is
essential to have these DLLs (IRemoteInterface.dll, IIdlglib.dll and TekDotNetLib.dll) in same folder
location as that of TekExpressClient.dll.

What steps does a client need to follow?

The following are the steps that a client needs to follow to use the TekExpressClient.dll to programmatically
control the server:

A client UI must be developed to access the interfaces exposed through the server. This client needs to
load TekExpressClient.dll to access the interfaces. Once the TekExpressClient.dll is loaded, the
client UI can call the specific functions to run the operations requested by the client. Once the client is
up and running, it must do the following to run a remote operation:

1. The client needs to provide the IP address of the PC at which the server is running in order to connect
to the server.

2. The client needs to lock the server application to avoid conflict with any other Client that may try to
control the server simultaneously. “Lock” would also disable all user controls on server so that server
state cannot be changed by manual operation.

3. If any other client tries to access a server which is locked, it will get a notification that the server
is locked by another client.

4. When the client has connected to and locked the server, the client can access any of the programmatic
controls to run the remote automations.

5. Once the client operations are completed, the server needs to be “unlocked” by the client.

Server and Client Proxy Objects

Remote Proxy Object
The server exposes a remote object to let the remote client access and perform the server side operations
remotely. The proxy object is instantiated and exposed at the server-end through marshalling.
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The following is an example:

RemotingConfiguration.RegisterWellKnownServiceType (typeof (TekExpressRe-

moteInterface), “TekExpress Remote interface”, WellKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side. The client gets the
reference to this object when the client gets connected to the server.

For example,

//Get a reference to the remote object

remoteObject = (IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),

URL.ToString());

Client Proxy Object
Client exposes a proxy object to receive certain information.

For example,

//Register the client proxy object

WellKnownServiceTypeEntry[] e = RemotingConfiguration.GetRegisteredWell-

KnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterWellKnownServiceType(typeof(ClientInterface),

“Remote Client Interface”, WellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling

RemotingServices.Marshal(clientInterface, "Remote Client Inteface");

The client proxy object is used for the following:

1. To get the secondary dialog messages from the server.

2. To get the file transfer commands from the server while transferring the report.

Click here to see examples.
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clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);

clientObject.clientIntf.TransferBytes(buffer, read, fileLength);

To know more on the topics below, click the links.

Secondary Dialog Message Handling

The secondary dialog messages from the Secondary Dialog library are redirected to the client-end when a
client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to be displayed is checked
and if a remote connection is detected, the messages are directed to the remote end.

File Transfer Events

When the client requests the transfer of the report, the server reads the report and transfers the file by
calling the file transfer methods at the client-end.

Client Programmatic Interface: An Example
An example of the client programmatic interface is described and shown as follows:
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1. Connect to a server or remote object using the programmatic interface provided.

2. Get the client ID that is created when connecting to the remote object. This client ID is one of the
required parameters to communicate with the server.

NOTE. Server identifies the client with this ID only and rejects any request if the ID is invalid.

3. Lock the server for further operations. This disables the application interface.

NOTE. You can get values from the server or set values from the server to the client only if application is
locked.

4. Register for receiving notifications on status change events on the server. To register you need to
give a handler as a parameter.

NOTE. Whenever there is a change in the status of the server, all the clients registered with the server
receive a notification from the server.

5. Select the tests that you want to run through the programmatic interface.

6. Set the necessary parameters for each test.

7. Run the tests.

8. Poll for the status of the application.

NOTE. You can skip this step if you are registered for the status change notification and when the status is
Ready.

9. After completing the tests, get the results.

10. Create a report or display the results and verify or process the results.

11. Unlock the server once you complete all the tasks.

12. Disconnect from the remote object.

Handler of Status Change Notification
1. Get the status. If the status is Wait or Error, get the information which contains the title, message

description, and the expected responses for the status.

2. Perform the actions based on the status information.

3. Set the response as expected.
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D-PHY Application Command Arguments and Queries
Connect through an IP address (see page 127)

Lock the server (see page 128)

Disable the popups (see page 129)

Set or get the DUT ID (see page 130)

Set the configuration parameters for a suite or measurement (see page 130)

Query the configuration parameters for a suite or measurement (see page 133)

Select a measurement (see page 135)

Select a suite (see page 136)

Select a channel (see page 136)

Configure the selected measurement (see page 139)

Run with set configurations or stop the run operation (see page 141)

Handle Error Codes (see page 150)

Get or set the timeout value (see page 142)

Wait for the measurement to complete (see page 142)

After the measurement is complete (see page 144)

Save, recall, or check if a session is saved (see page 148)

Unlock the server (see page 149)

Disconnect from server (see page 149)

string id

Name Type Direction Description
id string IN Identifier of the client that is

performing the remote function.
xxx

Ready: Test configured and ready to start.

Running: Test running.

Paused: Test paused.

Wait: A popup that needs your inputs.

Error: An error is occurred.
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string dutName

Name Type Direction Description
dutName string IN The new DUT ID of the setup.
xxx

out bool saved

Name Type Direction Description
saved bool OUT Boolean representing whether the

current session is saved.
xxx

This parameter is used as a check in SaveSession() and SaveSessionAs() functions.

string ipAddress

Name Type Direction Description
ipAdress string IN The ip address of the server to which the client

is trying to connect to. This is required to
establish the connection between the server
and the client.

xxx

out string clientID

Name Type Direction Description
clientid String OUT Identifier of the client that is connected to the

server.
clientId = unique number + ipaddress of the
client. For example, 1065–192.157.98.70

xxx

NOTE. If the dutName parameter is null, the client is prompted to provide a valid DUT ID.

NOTE. The server must be active and running for the client to connect to the server. Any number of
clients can be connected to the server at a time.

NOTE. When the client is disconnected, it is unlocked from the server and then disconnected. The id
is reused.
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string dutId

Name Type Direction Description
dutId string OUT The DUT ID of the setup.
xxx

The dutId parameter is set after the server processes the request.

string device

Name Type Direction Description
device string IN Specifies the name of the device.
xxx

string suite

Name Type Direction Description
suite string IN Specifies the name of the suite.
xxx

string test

Name Type Direction Description
test string IN Specifies the name of the test to

obtain the pass or fail status.
xxx

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a test.
xxx

int rowNr

Name Type Direction Description
rowNr int IN Specifies the zero based row index of

the sub-measurement for obtaining
the result value.

xxx

NOTE. When the client tries to lock a server that is locked by another client, the client gets a
notification that the server is already locked and it must wait until the server is unlocked. If the client
locks the server and is idle for a certain amount of time then the server is unlocked automatically
from that client.
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out string[] status

Name Type Direction Description
status string array OUT The list of status messages generated

during run.
xxx

string name

Name Type Direction Description
name string IN The name of the session being

recalled.
xxx

The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

NOTE. When the run is performed, the status of the run is updated periodically using a timer.

string name

Name Type Direction Description
name string IN The name of the session being

saved.
xxx

The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

Once the session is saved under ‘name’ you cannot use this method to save the session in a different
name. Use SaveSessionAs instead.

string name

Name Type Direction Description
name string IN The name of the session being

recalled.
xxx

The same session is saved under different names using this method. The name parameter cannot be
empty. If it is empty, the client is prompted to provide a valid name.

bool isSelected

Name Type Direction Description
isSelected bool IN Selects or deselects a test.
xxx
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string time

Name Type Direction Description
time string IN The time in seconds

which refers to the timeout
period.

xxx

The time parameter gives the timeout period, that is the time the client is allowed to be locked and
idle. After the timeout period if the client is still idle, it gets unlocked.

The time parameter should be a positive integer. Else, the client is prompted to provide a valid
timeout period.

bool_verbose

Name Type Direction Description
_verbose bool IN Specifies whether the verbose mode

should be turned ON or OFF.
xxx

NOTE. When the session is stopped, the client is prompted to stop the session and is stopped at
the consent.

string filePath

Name Type Direction Description
filePath string IN The location where the report must

be saved in the client.
xxx

NOTE. If the client does not provide the location to save the report, the report is saved at
C:\ProgramFiles.

NOTE. When the client is disconnected, the client is automatically unlocked.

out string caption

Name Type Direction Description
caption String OUT The wait state or error state message sent to

you.
xxx
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out string message

Name Type Direction Description
message String OUT The wait state/error state message to you.
xxx

out string[] buttonTexts

Name Type Direction Description
buttonTexts string array OUT An array of strings containing the

possible response types that you can
send.

xxx

string response

Name Type Direction Description
response string IN A string containing the response

type that you can select (it must be
one of the strings in the string array
buttonTexts).

xxx

out string clientID

Name Type Direction Description
clientID String OUT Identifier of the client that is connected to the

server.
clientID = unique number + ipaddress of the
client. For example, 1065–192.157.98.70

xxx
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Connect Through an IP Address
Command name Parameters Description Return Value Example
Connect() string

ipAddress (see
page 122)
out string
clientID (see
page 122)

This method
connects the client
to the server.
Note (see
page 122)
The client provides
the IP address
to connect to the
server.
The server
provides a unique
client identification
number when
connected to it.

Return value is
either True or
False.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as boolean
returnval = m_Client.Con-
nect(ipaddress,m_clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Lock the Server
Command name Parameters Description Return Value Example
LockSession() string clientID

(see page 126)
This method locks
the server.
Note (see
page 123)
The client must
call this method
before running
any of the remote
automations. The
server can be
locked by only one
client.

String value that
gives the status
of the operation
after it has been
performed.
The return value
is "Session
Locked...” on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval =
m_Client.LockServer(clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Disable the Popups
Command name Parameters Description Return Value Example
SetVerboseMode() string clientID

(see page 126)
bool _verbose
(see page 125)

This method sets
the verbose mode
to either true or
false.
When the value
is set to true,
then any of the
message boxes
appearing during
the application
will be routed to
the client machine
which is controlling
TekExpress.
When the value is
set to false, then all
the message boxes
are shown on the
server machine.

String that gives
the status of
the operation
after it has been
performed.
When Verbose
mode is set to
true, the return
value is “Verbose
mode turned on.
All dialog box
will be shown to
client ...”.
When Verbose
mode is set to
false, the return
value is “Verbose
mode turned off.
All dialog box
will be shown to
server ...”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Verbose mode is turned on
return=m_Client.SetVerbose-
Mode(clientID, true)
Verbose mode is turned off
returnval=m_Client.SetVerbose-
Mode(clientID, false)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Set or Get the DUT ID
Command name Parameters Description Return Value Example
SetDutId() string clientID

(see page 126)
string dutName
(see page 122)

This method
changes the DUT
ID of the set up.
The client must
provide a valid
DUT ID.

String that gives
the status of
the operation
after it has been
performed.
Return value
is “DUT Id
Changed...” on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
return=m_Client.SetDutId(clien-
tID,desiredDutId)
Note (see page 122)

GetDutId() string clientID
(see page 126)
string dutId (see
page 123)

This method gets
the DUT ID of the
current set up.

String that gives
the status of
the operation
after it has been
performed.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
return=m_Client.GetDutid(clien-
tID, out DutId)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Set the Configuration Parameters for a Suite or Measurement
Command name Parameters Description Return Value Example
SetGeneralParam-
eter

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method
sets the number
of video lanes
for the selected
measurement.

NOTE. Using
this command we
can select a lane,
channel, or source
type.

String that gives
the status of
the operation
after it has been
performed.
The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Select Channel (see page 131)
Select Measurement Method
(see page 131)
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Command name Parameters Description Return Value Example
SetAnalyzeParam-
eter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method sets
the configuration
parameters in the
Analyze panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Clientis a reference to the
Client class in the Client DLL
returnval as string
Configure Analyze parameters
for Data Lane Rise Time (see
page 132)

SetAcquireParame-
ter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method sets
the configuration
parameters in the
Acquire panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal = re-
moteObject.Se-
tAcquireParam-
eter(id, device,
suite, test, pa-
rameterString)
if ((OP_STATUS)

returnVal !=
OP_STA-
TUS.SUC-
CESS)

return Command-
Failed(returnVal)

Configure Acquire Parameters
for Data Lane Rise Time (see
page 132)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Select Channel Example
returnval=mClient.SetGeneralParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Data + Signal connected to Real Time Scope at$Channel 1")

Select Measurement Method Example
returnval=mClient.SetGeneralParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Measurement Method$Automatic")
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Configure Analyze Parameters for Data Lane Rise Time Example

Parameter Example
Trigger Type returnval = mClient.SetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Type$Transition")
Trigger Source returnval = mClient.SetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Source$Ch1")
Trigger Upper Level (V) returnval = mClient.SetAnalyzeParameter(clientID,"D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Upper Level (V)$1")
Trigger Lower Level (V) returnval = mClient.SetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Lower Level
(V)$0.05")

Trigger Time (ps) returnval = mClient.SetAnalyzeParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Time (pS)$500")

Trigger Transition returnval = mClient.SetAnalyzeParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Transition$Greater
Than")

Trigger Slope returnval = mClient.SetAnalyzeParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Slope$Positive)

Trigger If Violation returnval = mClient.SetAnalyzeParameter(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger If Violation$Occurs")

xxx

Data Lane Rise Time Configure Parameter Example

Parameter Example
Vertical Scale (mV) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Scale
(mV)$200")

Vertical Position (div) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Position
(div)$–2.6")

Vertical Offset (V) returnval = mClient.SetAcquireParameter(clientID,"D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Offset (V)$0")

Horizontal Scale (us) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Horizontal Scale
(us)$8")

Sample Rate (GS/s) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Sample Rate
(GS/s)$12.5")

Record Length returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Record
Length$500000")

xxx
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Query the Configuration Parameters for a Suite or Measurement
Command name Parameters Description Return Value Example
GetGeneralParam-
eter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method
gets the general
configuration
parameters for
a given suite or
measurement.

The return value
is the general
configuration
parameter for
a given suite or
measurement
that is set.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Query Channel (see page 134)
Query Measurement Method
(see page 134)

GetAnalyzeParam-
eter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method gets
the configuration
parameters set
in the Analyze
panel of the
Configuration
Panel dialog box
for a given suite or
measurement.

The return
value is the
configuration
parameter set
in the Analyze
panel of the
Configuration
Panel dialog box
for a given suite
or measurement.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Query Analyze Parameters
for Data Lane Rise Time (see
page 135)

GetAcquireParame-
ter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method gets
the configuration
parameters set in
the Acquire panel
for a given suite or
measurement.

The return
value is the
configuration
parameter set in
the Acquire panel
for a given suite
or measurement.

Query Acquire Parameters
for Data Lane Rise Time (see
page 134)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Query Channel Example
returnval=mClient.GetGeneralParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Data + Signal connected to Real Time Scope at")

Query Measurement Method Example
returnval=mClient.GetGeneralParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Measurement Method")

Query Data Lane Rise Time Acquire Parameter Examples

Parameter Example
Vertical Scale (mV) returnval = mClient.GetAcquireParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Scale (mV)")
Vertical Position (div) returnval = mClient.GetAcquireParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Position
(div)")

Vertical Offset (V) returnval = mClient.GetAcquireParameter(clientID,"D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Offset (V)")

Horizontal Scale (us) returnval = mClient.GetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Horizontal Scale
(us)")

Sample Rate (GS/s) returnval = mClient.GetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Sample Rate (GS/s)")

Record Length returnval = mClient.GetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Record Length")

xxx
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Query Data Lane Rise Time Analyze Parameter Examples

Parameter Example
Trigger Type returnval = mClient.GetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Type")
Trigger Source returnval = mClient.GetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Source")
Trigger Upper Level (V) returnval = mClient.GetAnalyzeParameter(clientID,"D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Upper Level (V)")
Trigger Lower Level (V) returnval = mClient.GetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Lower Level (V)")
Trigger Time (ps) returnval = mClient.GetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Time (pS)")
Trigger Transition returnval = mClient.GetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Transition")
Trigger Slope returnval = mClient.GetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger Slope)
Trigger If Violation returnval = mClient.GetAnalyzeParameter(clientID, "D-PHY",

"Transmitter", "1.1.3 Data Lane Rise Time", "Trigger If Violation")
xxx

Select a Measurement
Command name Parameters Description Return Value Example
SelectTest() string clientID

(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
bool isSelected
(see page 124)

This method
selects or
deselects a given
test.
Setting parameter
isSelected to true,
you can select a
measurement.
Setting parameter
isSelected to false,
you can deselect a
measurement.

String that
displays the
status of the
operation after
it has been
performed.
The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Select Measurement (Data
Lane Rise Time):
returnval=m_Client.Se-
lectTest(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane
Rise Time", true)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Select a Suite
Command name Parameters Description Return Value Example
SelectSuitet() string clientID

(see page 126)
string device
(see page 123)
string suite (see
page 123)
bool isSelected
(see page 124)

This method
selects or
deselects a given
suite.
Setting parameter
isSelected to true,
you can select a
suite.
Setting parameter
isSelected to false,
you can deselect a
suite.

String that gives
the status of
the operation
after it has been
performed.
The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Select Suite (Default):
returnval=m_Client.Se-
lectTest(clientID, "D-PHY",
"Transmitter", true)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Select a Channel
Command name Parameters Description Return Value Example
SetGeneralParame-
ter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method sets
the parameters
that are not
specific to any
given test.

NOTE. Using
this command we
can select a lane,
channel, or source
type.

String that gives
the status of
the operation
after it has been
performed.
The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Select Channel (see page 137)
Select Measurement Method
(see page 137)
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Command name Parameters Description Return Value Example
SetAnalyzeParame-
ter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method sets
the configuration
parameters in the
Analyze panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Clientis a reference to the
Client class in the Client DLL
returnval as string
Configure Analyze parameters
for Data Lane Rise Time (see
page 138)

SetAcquireParame-
ter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method sets
the configuration
parameters in the
Acquire panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal = re-
moteObject.Se-
tAcquireParam-
eter(id, device,
suite, test, pa-
rameterString)
if ((OP_STATUS)

returnVal !=
OP_STA-
TUS.SUC-
CESS) return
Command-
Failed(re-
turnVal)

Configure Acquire Parameters
for Data Lane Rise Time (see
page 138)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Select Channel Example
returnval=mClient.SetGeneralParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Data + Signal connected to Real Time Scope at$Channel 1")

Select Measurement Method Example
returnval=mClient.SetGeneralParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise
Time", "Measurement Method$Automatic")
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Configure Analyze parameters for Data Lane Rise Time Example

Parameter Example
Trigger Type returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Type$Transition")
Trigger Source returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Source$Ch1")
Trigger Upper Level (V) returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Upper Level (V)$1")
Trigger Lower Level (V) returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Lower Level (V)$0.05")
Trigger Time (pS) returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "TriggerTime (pS)$500")
Trigger Transition returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Transition$Greater Than")
Trigger Slope returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Slope$Positive")
Trigger If Violation returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger If Violation$Occurs")
xxx

Configure Acquire Parameters

Parameter Example
Vertical Scale (mV) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Scale
(mV)$200")

Vertical Position (div) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Position
(div)$–2.6")

Vertical Offset (V) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Offset (V)$0")

Horizontal Scale (us) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Horizontal Scale
(us)$8")

Sample Rate (GS/s) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Sample Rate
(GS/s)$12.5")

Record Length returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Record
Length$500000")

xxx
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Configure the Selected Measurement
Command name Parameters Description Return Value Example
SetAnalyzeParame-
ter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method
sets the Analyze
parameters
(Configuration
parameters) for a
given test.

The return
value is "" (an
empty String) on
success.

m_Client = new Client()
//m_Clientis a reference to
the Client class in the Client DLL
returnval as string
Configure Analyze Parameters
for Data Lane Rise Time (see
page 140)

SetAcquireParame-
ter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method
sets the Acquire
parameters in
the Acquire panel
of the Configure
Dialog box for a
given test.

returnVal = re-
moteObject.Se-
tAcquireParam-
eter(id, device,
suite, test, pa-
rameterString)
if ((OP_STA-
TUS)

returnVal !=
OP_STA-
TUS.SUC-
CESS) re-
turn Com-
mand-
Failed(re-
turnVal)

m_Client = new Client()
//m_Clientis a reference to
the Client class in the Client DLL
returnval as string
Configure Acquire Parameters
for Data Lane Rise Time (see
page 140)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Data Lane Rise Time Configure Parameter Example

Parameter Example
Vertical Scale (mV) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Scale
(mV)$200")

Vertical Position (div) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Position
(div)$–2.6")

Vertical Offset (V) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Vertical Offset (V)$0")

Horizontal Scale (us) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Horizontal Scale
(us)$8")

Sample Rate (GS/s) returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Sample Rate
(GS/s)$12.5")

Record Length returnval = mClient.SetAcquireParameter(clientID, "D-PHY", "Transmitter",
"1.1.3 Data Lane Rise Time", "Data Lane Rise Time$Record
Length$500000")

xxx

Data Lane Rise Time Analyze Parameter Example

Parameter Example
Trigger Type returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Type$Transition")
Trigger Source returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Source$Ch1")
Trigger Upper Level (V) returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Upper Level (V)$1")
Trigger Lower Level (V) returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Lower Level (V)$0.05")
Trigger Time (pS) returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "TriggerTime (pS)$500")
Trigger Transition returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Transition$Greater Than")
Trigger Slope returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger Slope$Positive")
Trigger If Violation returnval=mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter",

"1.1.3 Data Lane Rise Time", "Trigger If Violation$Occurs")
xxx
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Run with Set Configurations or Stop the Run Operation
Command name Parameters Description Return Value Example
Run() string clientID

(see page 126)
Runs the selected
tests. Note (see
page 124)
Once the server
is set up and is
configured, it can
be run remotely
using this function.

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Run started..."
on success.

m_Client = new Client()
//m_Clientis a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Run(clien-
tID)

Stop() string clientID
(see page 126)

Stops the currently
running tests. Note
(see page 125)

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Stopped..." on
success.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Stop(clien-
tID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Get or Set the Timeout Value
Command name Parameters Description Return Value Example
GetTimeOut() string clientID

(see page 126)
Returns the current
timeout period set
by the client.

String that gives
the status of
the operation
after it has been
performed.
The default
return value is
1800000.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.GetTime-
Out()

SetTimeOut() string clientID
(see page 126)
string time (see
page 125)

Sets a timeout
period specified by
client. After expiry
of this timeout
period, the server
is automatically
unlocked.

String that gives
the status of
the operation
after it has been
performed.
On success the
return value is
“TimeOut Period
Changed”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.SetTime-
Out(clientID, desiredTimeOut)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Wait for the Test to Complete
The commands in this group are executed while tests are running. The GetCurrentStateInfo() and
SendResponse() commands are executed when application is running and in wait state.

Command name Parameters Description Return Value Example
ApplicationStatus() string clientID

(see page 126)
This method gets the
status of the server
application.
The states at a given
time are Ready,
Running, Paused,
Wait, or Error. (see
page 121)

String value that
gives the status
of the server
application.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Applica-
tionStatus(clientID)
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Command name Parameters Description Return Value Example
QueryStatus() string clientID

(see page 126)
out string[]
status (see
page 124)

It is an interface for
the user to transfer
Analyze panel status
messages from the
server to the client.

String that gives
the status of
the operation
after it has been
performed.
On success the
return value is
“Transferred...”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnVal=m_Client.QueryS-
tatus(clientID, out statusMes-
sages)
if ((OP_STATUS)returnVal ==
OP_STATUS.SUCCESS)

return “Status updated...”
else

return CommandFailed(re-
turnVal)

GetCurrentState-
Info()

NOTE. This
command is
used when the
application is
running and is in
the wait or error
state.

string clientID
(see page 126)
out string
caption (see
page 125)
out string
message (see
page 126)
out string[]
buttonTexts
(see page 126)

This method gets
the additional
information of the
states when the
application is in Wait
or Error state.
Except client ID, all
the others are out
parameters.

This command
does not return
any value.
This function
fills up the out
parameters that
are passed
when invoking
this function.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
m_Client.GetCurrentState-
Info(clientID, caption,message,
buttonTexts)

SendResponse()

NOTE. This
command is
used when the
application is
running and is in
the wait or error
state.

string clientID
(see page 126)
out string
caption (see
page 125)
out string
message (see
page 126)
string response
(see page 126)

After receiving the
additional informa-
tion using the method
GetCurrentState-
Info(), the client can
decide on the re-
sponse to send and
send the response to
the application using
this function. The
response should be
one of the strings that
was earlier received
as a string array in
the GetCurrentState-
Info function.The
_caption and _mes-
sage should match
the information re-
ceived earlier in the
GetCurrentStateInfo
function.

This command
does not return
any value.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
m_Client.SendResponse(cli-
entID, caption,message,
response)

xxx
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

After the Test is Complete
Command name Parameters Description Return Value Example
GetPassFailSta-
tus()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)

This method gets
the pass or fail
status of the
measurement after
test completion.

NOTE. Execute
this command
after completing
the measurement.

String that gives
the status of
the operation
after it has been
performed.
Returns the pass
or fail status in
the form of a
string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.GetPass-
FailStatus(clientID, device,
suite, ”1.1.3 Data Lane Rise
Time”) //Pass or Fail

GetResultsValue() string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)

This method gets
the result values of
the measurement
after the run.

String that gives
the status of
the operation
after it has been
performed.
Returns the result
value in the form
of a string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as srting
returnval=m_Client.GetRe-
sultsValue(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane
Rise Time", "Measured Value")
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Command name Parameters Description Return Value Example
GetResultsValue-
ForSubMeasure-
ments()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 123)
int rowNr (see
page 123)

This method gets
the result values
for individual sub-
measurements,
after the run.

String that gives
the status of
the operation
after it has been
performed.
Returns the result
value in the form
of a string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Data Lane Rise Time DP (nS)
returnval=m_Client.GetRe-
sultsValueForSubMeasure-
ments(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane
Rise Time", "1.1.3 Data Lane
Rise Time”, "Measured Value",0)
//For DP wfm
returnval=m_Client.GetRe-
sultsValueForSubMeasure-
ments(clientID, "D-PHY",
"Transmitter", "1.1.3 Data Lane
Rise Time", "Measured Value",1)
//For DN wfm

GetReportParame-
ter()

string clientID
(see page 126)
string device
(see page 123)
string suite (see
page 123)
string test (see
page 123)
string parame-
terString (see
page 147)

This method
gets the general
report details such
as oscilloscope
model,
TekExpress
version, and
D-PHY version.

The return
value is the
oscilloscope
model,
TekExpress
version, and
D-PHY version.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
Oscilloscope Model
returnval=m_Client.GetRe-
portParameter(clientID,"Scope
Model")
TekExpress Version
returnval=m_Client.GetReport-
Parameter(clientID,"TekExpress
Version")
D-PHY Version
returnval=m_Client.GetReport-
Parameter(clientID,"Application
Version")
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Command name Parameters Description Return Value Example
TransferReport() string clientID

(see page 126)
string filePath
(see page 125)

This method
transfers the report
generated after the
run.
The report
contains the
summary of the
run.
The client must
provide the
location where
the report is to
be saved at the
client-end.

String that gives
the status of
the operation
after it has been
performed.
Transfers all the
result values in
the form of a
string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.TransferRe-
port(clientID,"C:\Report”)

TransferWave-
forms()

string clientID
(see page 126)
string filePath
(see page 125)

This method
transfers all the
waveforms from
the folder for the
current run.

NOTE. For each
click of Run
button, a folder
is created in the X:
drive. Transfer the
waveforms before
clicking the Run
button.

String that gives
the status of
the operation
after it has been
performed.
Transfers all the
waveforms in the
form of a string.
On success the
return value is
“Transferred...”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Transfer-
Waveforms(clientID,"C:\Wave-
forms”)

TransferImages() string clientID
(see page 126)
od
string filePath
(see page 125)

This method
transfers all
the images
(screenshots) from
the folder for the
current run (for
a given suite or
measurement).

NOTE. For each
click of Run
button, a folder
is created in the X:
drive. Transfer the
waveforms before
clicking the Run
button.

String that gives
the status of
the operation
after it has been
performed.
Transfers all the
images in the
form of a string.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.TransferIm-
ages(clientID, "C:\Waveforms”)

xxx

146 TekExpress D-PHY Automated Solution



TekExpress Programmatic Interface After the Test is Complete

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

string parameterString

Name Type Direction Description
parameterString string IN Specifies the oscilloscope model,

TekExpress version, and D-PHY
version.

xxx
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Save, Recall, or Check if a Session is Saved
Command name Parameters Description Return Value Example
CheckSession-
Saved()

string clientID
(see page 126)
out bool saved
(see page 122)

This method is
called when a
check is to be
made to know if
the current session
is saved.

Return value is
either True or
False.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Check-
SessionSaved(m_clientID, out
savedStatus)

RecallSession() string clientID
(see page 126)
string name
(see page 124)

Recalls a saved
session. The
name of the
session is provided
by the client.

String that gives
the status of
the operation
after it has been
performed.
The return value
is “Session
Recalled...”.

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.RecallSes-
sion(clientID, savedSession-
Name)

SaveSession() string clientID
(see page 126)
string name
(see page 124)

Saves the current
session. The
name of the
session is provided
by the client.

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Session
Saved..."/"Failed...".

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.SaveSes-
sion(clientID, desiredSession-
Name)

SaveSessionAs() string clientID
(see page 126)
string name
(see page 124)

Saves the current
session in a
different name
every time this
method is called.
The name of the
session is provided
by the client.

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Session
Saved...".

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.SaveSes-
sionAs(clientID, desiredSes-
sionName)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Unlock the Server
Command name Parameters Description Return Value Example
UnlockSession() string clientID

(see page 126)
This method
unlocks the server
from the client.
The ID of the client
to be unlocked
must be provided.
Note (see
page 125)

String that gives
the status of
the operation
after it has been
performed.
The return value
is "Session
Un-Locked...".

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Unlock-
Server(clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Disconnect from the Server
Command name Parameters Description Return Value Example
Disconnect() string clientID

(see page 126)
This method
disconnects
the client from
the server it is
connected to.
Note (see
page 122)

Integer value that
gives the status
of the operation
after it has been
performed.
1 for Success
–1 for Failure

m_Client = new Client()
//m_Client is a reference to the
Client class in the Client DLL
returnval as string
returnval=m_Client.Discon-
nect(m_clientID)

xxx

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Handle Error Codes
The return value of the remote automations at the server-end is OP_STATUS which is changed to a string
value depending on its code and returned to the client. The values of OP_STATUS are as follows:

Value Code Description
FAIL −1 The operation failed.
SUCCESS 1 The operation succeeded.
NOTFOUND 2 Server not found
LOCKED 3 The server is locked by another client, so operation cannot

be performed.
UNLOCK 4 The server is not locked. Lock the server before performing

the operation.
NULL 0 Nothing
xxx

Program Example
This program example shows how to communicate between a PC and TekExpress D-PHY remotely.

A typical application does the following:

1. Start the application.

2. Connect through an IP address.

m_Client.Connect("localhost") ’True or False

clientID = m_Client.getClientID

3. Lock the server.

m_Client.LockServer(clientID)

4. Disable the Popups.

m_Client.SetVerboseMode(clientID, false)

5. Set the Dut ID.

m_Client.SetDutId(clientID, "DUT_Name")

6. Select a measurement.

mClient.SelectTest(clientID, "D-PHY", "Transmitter", "1.1.3 Data Lane Rise

Time", true) ’Data Lane Rise Time measurement selected

7. Select a channel.

150 TekExpress D-PHY Automated Solution



TekExpress Programmatic Interface Program Example

mClient.SetGeneralParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Data + Signal connected to Real Time Scope at$Channel 1")

Data Lane Rise Time measurement selected

8. Configure the selected measurement.

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Trigger Type$Transition") ’Data Lane Rise Time measurement
selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Trigger Source$Ch1") ’Data Lane Rise Time measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Trigger Upper Level(V)$1") ’Data Lane Rise Time measurement
selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Trigger Lower Level(V)$0") ’Data Lane Rise Time measurement
selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Trigger Time(pS)$500") ’Data Lane Rise Time measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Trigger Transition$Greater Than") ’Data Lane Rise Time
measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Trigger Slope$Positive") ’Data Lane Rise Time measurement selected

mClient.SetAnalyzeParameter(clientID, "D-PHY", "Transmitter", "1.1.3 Data

Lane Rise Time", "Trigger If Violation$Occurs") ’Data Lane Rise Time measurement
selected

9. Run with set configurations.

m_Client.Run(clientID)

10. Wait for the test to complete.

Do

Thread.Sleep(500)

m_Client.Application_Status(clientID)

Select Case status

Case "Wait"

’Get the Current State Information

mClient.GetCurrentStateInfo(clientID, WaitingMsbBxCaption, WaitingMsbBxMes-

sage, WaitingMsbBxButtontexts)

’Send the Response
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mClient.SendResponse(clientID, WaitingMsbBxCaption, WaitingMsbBxMessage,

WaitingMsbBxResponse)

End Select

Loop Until status = "Ready"

11. After the Test is Complete.

’Save all results values from folder for current run

m_Client.TransferResult(clientID, logDirname)

’Save all waveforms from folder for current run

m_Client.TransferWaveforms(clientID, logDirname)

’Save all images from folder for current run

m_Client.TransferImages(clientID, logDirname)

12. Unlock the server.

m_Client.UnlockServer(clientID)

13. Disconnect from server.

m_Client.Disconnect()

14. Exit the application.
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NI TestStand Client Example

The following is an example for NI TestStand Client available in the path, C:\Program
Files\Tektronix\TekExpress\TekExpress D-PHY\Examples\Programmatic

Interface\TestStand
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Reference Group 1 Tests

Group 1 Tests

Test 1.1.1 Data Lane LP-TX Thevenin Output High Level Voltage (VOH)
Data Lane LP-TX Thevenin Output High Level Voltage is calculated using the following algorithm:

Acquire the Dp and Dn waveforms by setting the transition trigger from LP to HS mode (LP11-10) on
the oscilloscope.

Using post processing:

Traverse the Dp waveform and find the LP signaling sequence.

In the LP sequence region, find the absolute peak-to-peak value. VOH is measured as the mode of
all the waveform samples greater than 50% of the absolute peak-to-peak.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Test 1.1.2 Data Lane LP-TX Thevenin Output Low Level Voltage (VOL)
Data Lane LP-TX Thevenin Output Low Level Voltage is calculated using the following algorithm:
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Acquire the Dp and Dn waveforms by setting the transition trigger from LP to HS mode (LP11-10) on
the oscilloscope.

Using post processing:

Traverse the Dp waveform and find the LP signaling sequence.

In the LP sequence region, find the absolute peak-to-peak value. VOH is measured as the mode of
all the waveform samples lower than 50% of the absolute peak-to-peak.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Test 1.1.3 Data Lane Rise Time
Data Lane Rise Time is calculated using the following algorithm:

Acquire the Dp and Dn waveforms by setting the transition trigger from LP to HS mode (LP11-10)
on oscilloscope.

Using post processing:

Traverse the Dp waveform and find the LP signaling sequence.

In the LP sequence region, find the absolute peak-to-peak. VOH is measured as the mode of all
the waveform samples greater than 50% of the absolute peak-to-peak and VOL is measured as the
mode of all the waveform samples lower than 50% of the absolute peak-to-peak.

Find all the rising edges in the Dp waveform and find the 15%-85% rise time with reference to VOL
and VOH for each of the edges and average the results. This result is Rise Time (TRLP).

where,

Dp – Data positive waveform

Dn – Data negative waveform
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Test 1.1.4 Data Lane Fall Time
Data Lane Fall Time is calculated using the following algorithm:

Acquire the Dp and Dn waveforms by setting the transition trigger from LP to HS mode (LP11-10)
on oscilloscope.

Using post processing:

Traverse the Dp waveform and find the LP signaling sequence.

In the LP sequence region, find the absolute peak-to-peak. VOH is measured as the mode of all
the waveform samples greater than 50% of the absolute peak-to-peak and VOL is measured as the
mode of all the waveform samples lower than 50% of the absolute peak-to-peak..

Find all the falling edges in the Dp waveform and find the 15%-85% fall time with reference to
VOL and VOH for each of the edges and average the results. This result is Fall Time (TFLP).

where,

Dp – Data positive waveform

Dn – Data negative waveform
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Group 2 Tests

Test 1.2.1 Clock Lane LP-TX Thevenin Output High Level Voltage (VOH)
Clock Lane LP-TX Thevenin Output High Level Voltage is calculated using the following algorithm:

Acquire the Cp and Cn waveforms by setting the transition trigger from LP to HS mode (LP11-10)
on oscilloscope.

Using post processing:

Traverse the Cp waveform and find the LP signaling sequence.

In the LP-11 sequence region, find the absolute peak-to-peak. VOH is measured as the mode of all
the waveform samples greater than 50% of the absolute peak-to-peak.

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.2.2 Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL)
Clock Lane LP-TX Thevenin Output Low Level Voltage is calculated using the following algorithm:

158 TekExpress D-PHY Automated Solution



Reference Group 2 Tests

Acquire the Cp and Cn waveforms by setting the transition trigger from LP to HS mode (LP11-10)
on oscilloscope.

Using post processing:

Traverse the Cp waveform and find the LP signaling sequence.

In the LP-00 sequence region, find the absolute peak-to-peak. VOL is measured as the mode of all
the waveform samples lower than 50% of the absolute peak-to-peak.

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.2.3 Clock Lane Rise Time
Clock Lane Rise Time is calculated using the following algorithm:

Acquire the Cp and Cn waveforms by setting the transition trigger from LP to HS mode (LP11-10)
on oscilloscope.

Using post processing:

Traverse the Cp waveform and find the LP signaling sequence.

In the LP sequence region, find the absolute peak-to-peak and VOH is measured as the mode of all
the waveform samples greater than 50% of the absolute peak-to-peak and VOL is measured as the
mode of all the waveform samples lower than 50% of the absolute peak-to-peak.

Find all the rising edges in the Cp waveform and find the 15%-85% rise time with reference to VOL
and VOH for each of the edges and average the results. This result is Rise Time (TRLP).

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.2.4 Clock Lane Fall Time
Clock Lane Fall Time is calculated using the following algorithm:
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Acquire Cp and Cn waveform by setting the Transition trigger from LP to HS mode (LP11-10) on
oscilloscope.

Using post processing:

Traverse the Cp waveform and find the LP signaling sequence.

In the LP sequence region, find the absolute peak-to-peak and VOH is measured as the mode of all
the waveform samples greater than 50% of the absolute peak-to-peak and VOL is measured as the
mode of all the waveform samples lower than 50% of the absolute peak-to-peak.

Find all the falling edges in the Cp waveform and find the 15%-85% fall time with reference to
VOL and VOH for each of the edges and average the results. This result is Fall Time (TFLP).

where,

Cp – Clock positive waveform

Cn – Clock negative waveform

Group 3 Tests

Test 1.3.1 Data Lane HS Entry: Data Lane TLPX Value
Data Lane TLPX Value is calculated using the following algorithm:

Acquire Dp and Dn waveform by setting the Transition trigger from LP to HS mode (LP11-10)
on oscilloscope.

Using post processing, traverse the Dp waveform and find the Cursor 1 and Cursor 2 positions
corresponding to LP-01 signaling sequence as given:

Compute Dp–Dn and look for points with voltage greater than 550 mV. If the number of points
found is 0, then compute Dn–Dp and look for points with voltage greater than 550 mV. If the
number of points found is 0, then the signal is not correct. If the signal is correct, proceed with the
following steps on the difference signal (Diff):

In the Diff waveform, in the region corresponding to the LP signaling sequence region, find
the first rising edge and successive falling edge.

The time difference between these two edges at voltage level of 550 mV is TLPX.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform
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Cn – Clock negative waveform

Test 1.3.2 Data Lane HS Entry: THS-PREPARE Value
Data Lane THS-PREPARE Value is calculated using the following algorithm:

Acquire Dp and Dn waveform by setting the Transition trigger from LP to HS mode (LP11-10) on
the oscilloscope.

Using post processing, traverse the Dp waveform and find the Cursor2 and Cursor3 positions
corresponding to LP-00 signaling sequence as given below:

Subtract the Dp and Dn waveforms to obtain Dp-Dn.

In the LP signaling sequence, in Dp–Dn find the first rising edge and successive falling edge.
Cursor 2 is the point where the falling edge touches 550 mV.

Compute VOLHS:

Find the high speed sequence in the input waveform.

Find the highest and the lowest voltage values in the high speed sequence. The mode of all the
values greater than 50% of the peak-to-peak is the VOHHSand the mode of all the values less than
50% of the peak-to peak is the VOLHS.

Find the Cursor 3 position:

From the point corresponding to Cursor 2 on Dn, traverse to the right of the Dn waveform and find
a point that is less than or equal to the VOLHS. Mark this point as Marker 1.

From Marker 1, traverse both the Dn and Dp waveforms and find the first point which is greater
than or equal to VOHHS on either of Dn or Dp waveforms. Mark this point as Marker 2.

On the waveform where the Marker 2 point was found, traverse to the left of the waveform until a
point less than or equal to 70 mV is located. This is Cursor 3.

The time between Cursor 3 and Cursor 2 is THS-PREPARE.
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where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform

Test 1.3.3 Data Lane HS Entry: THS-PREPARE + THS-ZERO Value
Data Lane THS-PREPARE + THS-ZERO Value is calculated using the following algorithm:

Acquire Dp and Dn waveform by setting the Transition trigger from LP to HS mode (LP11-10) on
the oscilloscope.

Using post processing, traverse the Dp waveform and find the Cursor 2 and Cursor 4 positions
as below:

Subtract the Dp and Dn waveforms to obtain Dp–Dn.

In the LP signaling sequence, in Dp–Dn find the first rising edge and successive falling edge.
Marker 1 is the point where the falling edge touches 550 mV. Cursor 2 = Marker 1.

Compute VOLHS:

Find the high speed sequence in the input data waveforms.

Find the highest and the lowest voltage values in the high speed sequence. The mode of all the
values greater than 50% of the peak-to-peak is the VOHHS and the mode of all the values less than
50% of the peak-to peak is the VOLHS.
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Find the Cursor 4 position.

From the point corresponding to Marker 1 on Dn, traverse to the right of Dn waveform and find a
point that is less than or equal to the VOLHS. Mark this point as Marker 2.

From Marker 2, traverse both the Dn and Dp waveforms and find the first point which is greater
than or equal to VOHHS on either of Dn or Dp waveforms. Mark this point as Marker 3.

On the waveform where the Marker 3 point was found, traverse to the left of the waveform until a
point less than or equal to 70 mV is located. This is Marker 4.

On the waveform where the point corresponding to Marker 3 was found, traverse to the right and
find a point where the voltage is less than or equal to (VOHHS +VOLHS)/2. This is Marker 5.

Starting from Marker 5, on the same waveform where the point corresponding to Marker 5
was found, traverse further and find a point where the voltage is greater than or equal to
(VOHHS +VOLHS)/2. This is Marker 6. Marker 5–Marker 6 is almost 1High speed UI. Hence
Marker 5–3*(Marker 6–Marker 5) is the end point of THS-ZERO. Call this Marker 7.

THS-ZERO is the time between Marker 7 and Marker 4.

Cursor 4 = Marker 7

The time between Cursor 2 and Cursor 4 is THS-PREPARE + TZERO.

where,
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.3.4 Data Lane HS-TX Differential Voltages (VOD(0), VOD(1))
Data Lane HS-TX Differential Voltages (VOD(0), VOD(1)) is calculated using the following algorithm:
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NOTE. In the Manual Method, the measurement must be performed on a differential signal Instead of
a single-ended signal.

Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and the sampling rate of the
waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Identify all the HS regions in the input data waveforms.

In the HS regions of the input data waveforms, identify a ‘100000’ pattern to measure VOD(0) and
identify a ‘011111’ pattern to measure VOD(1) (00000 or 11111 is a region with about 5 UI interval
length).

Measure VOD(0) and VOD(1) values as the mean of all voltage samples between the centers of
fourth and fifth 0/1 bit respectively.

Average VOD(0) and VOD(1) across all instances of the pattern

where,
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.3.5 Data Lane HS-TX Differential Voltage Mismatch (VOD)
Data Lane HS-TX Differential Voltage Mismatch (VOD) is calculated using the following algorithm:

NOTE. In the Manual Method, the measurement must be performed on a differential signal Instead of
a single-ended signal.

Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and the sampling rate of the
waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Identify all the HS regions in the input data waveforms.

In the HS regions of the input data waveforms, identify a ‘100000’ pattern to measure VOD(0) and
identify a ‘011111’ pattern to measure VOD(1) (00000 or 11111 is a region with about 5 UI interval
length).

Measure VOD(0) and VOD(1) values as the mean of all voltage samples between the centers of
fourth and fifth 0/1 bit respectively.

Average VOD(0) and VOD(1) across all instances of the pattern

Compute ΔVOD = |VOD(1)| - |VOD(0)|

where,
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Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.3.6 Data Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP), VOHHS(DN))
Data Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP), VOHHS(DN)) is calculated using
the following algorithm:

Acquire Data Lane signals Dp and Dn, and the sampling rate of the waveform.

Identify all the HS regions in the input data waveforms.

In the input data waveform Dp, find the highest voltage across all the HS regions. This is VOHHS(Dp).
In the input data waveform Dn, find the highest voltage across all the HS regions. This is VOHHS(Dn).

where,
Dp – Data positive waveform
Dn – Data negative waveform

Test 1.3.7 Data Lane HS-TX Static Common Mode Voltages (VCMTX(0), VCVMTX(1))
Data Lane HS-TX Static Common Mode Voltages (VCMTX(0), VCVMTX(1)) is calculated using the
following algorithm:

Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and the sampling rate of the
waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Create an VCMTX waveform as VCMTXX = (Dp + Dn)/2.

Identify all the HS regions in the input data and VCMTX waveforms.

At the Mid-point of each Clock UI, check if the data is at Differential-0 or Differential-1 state.

Obtain the corresponding point on the VCMTXX waveform. If the data is Differential-0, the point is
added to VCMTX(0), else if the data is Differential-1, the point added to VCMTX(1).

Average all values of VCMTX(0) and VCMTX(1).

where,
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform
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Test 1.3.8 Data Lane HS-TX Static Common-Mode Voltage Mismatch (ΔVCMTX(1,0))
Data Lane HS-TX Static Common-Mode Voltage Mismatch (ΔVCMTX(1,0)) is calculated using the
following algorithm:

Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and the waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Create an VCMTX waveform as VCMTX = (Dp + Dn)/2.

Identify all the HS regions in the input data and VCMTX waveforms.

At the mid-point of each Clock UI, check if the data is at Differential-0 or Differential-1 state.

Obtain the corresponding point on the VCMTX waveform. If the data is Differential-0, the point is added
to VCMTX(0), else if the data is Differential-1, the point added to VCMTX(1).

Average all values of VCMTX(0) and VCMTX(1) and calculate ∆CMTX(1,0) = (VCMTX (1) – VCMTX (0))/2.

where,
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.3.9 Data Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz
Data Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz is calculated using the
following algorithm:

Acquire Data Lane signals Dp and Dn, Bandpass Filtered Data Lane signals FilteredDp and
FilteredDn, and the sampling rate.

Identify all the HS regions in the Filtered input data waveforms using Unfiltered Dp and Dn.

Find the minimum voltage in the filtered data HS region, Vmin. Find the maximum voltage in the
Filtered data HS region, Vmax

Compute Vpeak as, Vpeak = max (Vmax, abs(Vmin))

where,
Dp – Data positive waveform
Dn – Data negative waveform
FilteredDp – Bandpass Filtered Data positive waveform
FilteredDn – Bandpass Filtered Data negative waveform

Test 1.3.10 Data Lane HS-TX Dynamic Common-Level Variations Above 450MHz
Data Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz is calculated using the
following algorithm:
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Acquire Data Lane signals Dp and Dn, Bandpass Filtered Data Lane signals FilteredDp and
FilteredDn, and the sampling rate.

Identify all the HS regions in the Filtered input data waveforms using Unfiltered Dp and Dn.

Find the minimum voltage in the filtered data HS region, Vmin. Find the maximum voltage in the
Filtered data HS region, Vmax

Compute Vrms as:

where,
Dp – Data positive waveform
Dn – Data negative waveform
FilteredDp – Bandpass Filtered Data positive waveform
FilteredDn – Bandpass Filtered Data negative waveform

Test 1.3.11 Data Lane HS-TX 20%-80% Rise Time (tR)
Data Lane HS-TX 20%-80% Rise Time (tR) is calculated using the following algorithm:

Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and the sampling rate of the
waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Identify all the HS regions in the input data waveforms.

Compute VOD(0) and VOD(1).

In the HS regions of the input data waveforms identify a ‘000111’ pattern (000 or 111 is a region with
about 3 UI interval length).

Measure Rise-time, tR (as time between 20%-80% of the VOD), on the identified ‘000111’ pattern.

Average all values of tR.

where,
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.3.12 Data Lane HS-TX 80%-20% Fall Time (tF)
Data Lane HS-TX 80%-20% Fall Time (tF) is calculated using the following algorithm:
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Acquire Data Lane signals Dp and Dn, Clock Lane signals Cp and Cn, and the sampling rate of the
waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Identify all the HS regions in the input data waveforms.

Compute VOD(0) and VOD(1).

In the HS regions of the input data waveforms identify a ‘111000’ pattern (000 or 111 is a region with
about 3 UI interval length).

Measure Fall-time, tF (as time between 80%-20% of the VOD), on the identified ‘111000’ pattern.

Average all values of tF.

where,
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.3.13 Data Lane HS Exit: THS-TRAIL Value
Data Lane HS Exit: THS-TRAIL Value is calculated using the following algorithm:

Acquire Data Lane signals Dp and Dn, Clock Lane signals Clkp and Clkn(single-ended) or
Clkp(differential, Clkp – Clkn).

Identify the HS regions in the input clock waveform and estimate the UI.

Identify the LP regions using input data waveform. Let the number of LP regions be N.

From the beginning of every LP region, move backward in the waveform until the absolute
diff(Dp-Dn) is greater than 0.1v. Let these points be p(i), i=0 to (N-1).

From p(i), move forward in waveform until the absolute value of the diff(Dp-Dn) is less than 0.07v.
Let these points be q(i). q(i) marks the end of trail region.

From p(i) move backward in waveform until the point where single-ended signals Dp and Dn cross
each other. Let this point be r(i). r(i) marks the start of trail region.

Trail_Duration(i) = [p(i) – r(i)]

Compute the mean of trail durations observed at all HS to LP transitions.

TrailMean = (1/N)*(Sum(Trail_Duration(i))
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform
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Test 1.3.14 Data Lane HS Exit: 30%-85% Post-EOT Rise Time (TREOT)
Data Lane HS Exit: 30%-85% Post-EOT Rise Time (TREOT) is calculated using the following algorithm:

Acquire Data Lane signals Dp and Dn.

Identify the LP regions using input data waveform. Let the number of LP regions be N.

From the beginning of every LP region, move backward in the waveform until the absolute
diff(Dp-Dn) is greater than 0.1v. Let the point be p(i), i=0 to (N-1). From p(i), move forward in
waveform until the absolute value of the diff(Dp-Dn) is less than 0.07v. Let this point be q(i). q(i)
marks the start of TREOT region.

From q(i), move forward in waveform until the point where amplitude of single-ended signal Dp goes
greater than 0.88 volts. Let this point be r(i). r(i) marks the end of TREOT region.

TREOT_Duration(i) = [r(i) – q(i)]

Compute the mean of TREOT durations observed at all HS to LP transitions.

Group 4 Tests

Test 1.4.1 Clock Lane HS Entry: TLPX Value
Clock Lane HS Entry: TLPX Value is calculated using the following algorithm:

Acquire Clock Lane signals Cp and Cn, and the sampling rate of the waveform.

Obtain a differential clock signal as CnMinCp = Cn - Cp

Find the Low Speed UI, LS_UI (for Low Power region).

Identify a rising edge in the CnMinCp waveform and its corresponding fall edge (the rising and falling
edges are taken corresponding to 0.55 V limit)

Identify a point on the Cp waveform corresponding to the rising edge on CnMinCp. Mark this
as Cursor1.

Identify a point on the Cn waveform corresponding to the falling edge on CnMinCp. Mark this
as Cursor2.

TLPX = Cursor2 – Cursor1 is the required result.
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.4.2 Clock Lane HS Entry: TCLK-PREPARE Value
Clock Lane HS Entry: TCLK-PREPARE Value is calculated using the following algorithm:

Acquire Clock Lane signals Cp and Cn, and the sampling rate of the waveform.

Obtain a differential clock signal as CnMinCp = Cn - Cp
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Find the Low Speed UI, LS_UI (for Low Power region), VOL, and VOH.

Identify a falling edge in the CnMinCp waveform (the falling edge is taken corresponding to 0.55 V
limit). Identify a point on the Cn waveform corresponding to the falling edge on CnMinCp. Mark
this as Cursor1.

From Cursor1 move forward on Cn until you find a point lying below VOL. From this point move
forward on Cn until you find a point above VOH.

From this point traverse back until you find a point just above 0.070V. Mark this as Cursor 2.

TCLK-PREPARE = Cursor2 – Cursor1 is the required result.
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.4.3 Clock Lane HS Entry: TCLK-PREPARE+TCLK-ZERO Value
Clock Lane HS Entry: TCLK-PREPARE+TCLK-ZERO Value is calculated using the following algorithm:

Acquire Clock Lane signals Cp and Cn, and the sampling rate of the waveform.

Obtain a differential clock signal as CnMinCp = Cn - Cp

Find the Low Speed UI, LS_UI (for Low Power region), VOL, and VOH.

Identify a falling edge in the CnMinCp waveform (the falling edge is taken corresponding to 0.55 V
limit). Identify a point on the Cn waveform corresponding to the falling edge on CnMinCp. Mark the
end of TCLK-PREPARE as Cursor1.

Obtain VCMTX as, VCMTX= (Cp + Cn) / 2.

Traverse forward from Cursor1 and identify a point on Cn where Cn crosses (or goes below) VCMTX.
Mark this point as Cursor2.

TCLK-PREPARE + TCLK-ZERO = (Cursor2 – 3*UI – TCLK-PREPARE Begin) is the required result.
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.4.4 Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1))
Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1)) are calculated using the following algorithm:

Acquire Clock Lane signals Cp and Cn, and the waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Identify all the HS regions in the input clock waveforms.

In the HS regions of the input clock waveforms identify a ‘10’ pattern to measure VOD(0) and identify
a ‘01’ pattern to measure VOD(1) (0 or 1 is a region with about 1 UI interval length)
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Measure VOD(0) and VOD(1) as the mean of all voltage samples at the exact center of 0/1 bit
respectively.

Average VOD(0) and VOD(1) across all instances of the pattern

where,
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.4.5 Clock Lane HS-TX Differential Voltage Mismatch (VOD)
Clock Lane HS-TX Differential Voltage Mismatch (VOD) are calculated using the following algorithm:

Accept the following inputs:

Clock Lane signals Cp and Cn

Sampling rate

Identify the HS regions in the input clock waveform and estimate the UI.

In the HS regions of the input clock waveforms, identify a 10 pattern to measure VOD(0) and identify an
01 pattern to measure VOD(1) (0 or 1 is a region with about 1UI interval length)

VOD(0) and VOD(1) are measured as the mean of all voltage samples at the exact center of 0/1 bit
respectively.

VOD(0) and VOD(1) are averaged across all instances of the pattern

ΔVOD is calculated as, ΔVOD = VOD(1) –VOD(0)

Test 1.4.6 Clock Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP), VOHHS(DN))
Clock Lane HS-TX Single-Ended Output High Voltages (VOHHS(DP), VOHHS(DN)) are calculated
using the following algorithm:

where,

Acquire Clock Lane signals Cp and Cn, and the waveform.

Identify all the HS regions in the input data waveforms.

In the input data clock waveform Cp, find the highest voltage across all the HS regions. This is
VOHHS(Cp).

In the input data clock waveform Cn, find the highest voltage across all the HS regions. This is
VOHHS(Cn).

Cp – Clock positive waveform
Cn – Clock negative waveform
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Test 1.4.7 Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1), VCMTX(0))
Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1), VCMTX(0)) are calculated using
the following algorithm:

Acquire Clock Lane signals Cp and Cn, and the waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Create an VCMTX waveform as VCMTX = (Cp + Cn)/2

Identify all the HS regions in the input clock and VCMTX waveforms.

At the Mid-point of each Clock UI, check if the clock is at Differential-0 or Differential-1 state.

Obtain the corresponding point on the VCMTX waveform. If the clock is Differential-0, the point is
added to VCMTX(0), else if the clock is Differential-1, the point added to VCMTX (1).

Average all values of VCMTX(0) and VCMTX(1).

where,
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.4.8 Clock Lane HS-TX Static Common-Mode Voltage Mismatch (ΔVCMTX(1,0))
Clock Lane HS-TX Static Common-Mode Voltage Mismatch (ΔVCMTX(1,0)) is calculated using the
following algorithm:

Acquire Clock Lane signals Cp and Cn, and the waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Create an VCMTXwaveform as VCMTX = (Cp + Cn)/2

Identify all the HS regions in the input clock and VCMTX waveforms.

At the Mid-point of each Clock UI, check if the clock is at Differential-0 or Differential-1 state.

Obtain the corresponding point on the VCMTX waveform. If the clock is Differential-0, the point is
added to VCMTX(0), else if the clock is Differential-1, the point added to VCMTX (1).

Average all values of VCMTX (0) and VCMTX (1) and calculate ∆VCMTX(1,0)= (VCMTX (1) – VCMTX (0))/2.

where,
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform
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Test 1.4.9 Clock Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz
(ΔVCMTX(LF))

Clock Lane HS-TX Dynamic Common-Level Variations Between 50-450MHz (ΔVCMTX(LF)) is
calculated using the following algorithm:

Acquire Clock Lane signals Cp and Cn, Bandpass Filtered Clock Lane signals FilteredCp and
FilteredCn, and the sampling rate.

Identify all the HS regions in the Filtered input data waveforms using Unfiltered Cp and Cn.

Find the minimum voltage in the filtered clock HS region, Vmin. Find the maximum voltage in the
Filtered clock HS region, Vmax

Compute Vpeak as, Vpeak = max(Vmax, abs(Vmin))

where,
Cp – Clock positive waveform
Cn – Clock negative waveform
FilteredCp – Bandpass Filtered Clock positive waveform
FilteredCn – Bandpass Filtered Clock negative waveform

Test 1.4.10 Clock Lane HS-TX Dynamic Common-Level Variations Above 450MHz
(ΔVCMTX(HF))

Clock Lane HS-TX Dynamic Common-Level Variations Above 450MHz (ΔVCMTX(HF)) is calculated
using the following algorithm:

Acquire Clock Lane signals Cp and Cn, Bandpass Filtered Clock Lane signals FilteredCp and
FilteredCn, and the sampling rate.

Identify all the HS regions in the Filtered input data waveforms using Unfiltered Cp and Cn.

Find the minimum voltage in the filtered clock HS region, Vmin. Find the maximum voltage in the
Filtered clock HS region, Vmax

Compute Vrms as:

where,
Cp – Clock positive waveform
Cn – Clock negative waveform
FilteredCp – Bandpass Filtered Clock positive waveform
FilteredCn – Bandpass Filtered Clock negative waveform
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Test 1.4.11 Clock Lane HS-TX 20%-80% Rise Time (tR)
Clock Lane HS-TX 20%-80% Rise Time (tR) is calculated using the following algorithm:

Acquire Clock Lane signals Cp and Cn, and the waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Identify all the HS regions in the input data waveforms.

Compute VOD(0) and VOD(1).

In the HS regions of the input data waveforms identify a ‘01’ pattern (is a region alternating (low-high)
with about 1UI interval length).

Measure Rise-time, tR (as time between 20%-80% of the VOD), on the identified ‘01’ pattern

Average all values of tR.

where,
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.4.12 Clock Lane HS-TX 80%-20% Fall Time (tF)
Clock Lane HS-TX 80%-20% Fall Time (tF) is calculated using the following algorithm:

Acquire Clock Lane signals Cp and Cn, and the waveform.

Identify the HS regions in the input clock waveform and estimate the UI.

Identify all the HS regions in the input data waveforms.

Compute VOD(0) and VOD(1).

In the HS regions of the input data waveforms identify a ‘10’ pattern (is a region alternating (high-low)
with about 1 UI interval length).

Measure Fall-time, tF (as time between 80%-20% of the VOD), on the identified ‘10’ pattern.

Average all values of tF.

where,
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.4.13 Clock Lane HS Exit: THS-TRAIL Value
Clock Lane HS Exit: THS-TRAIL Value is calculated using the following algorithm:

Acquire Clock Lane signals Clkp and Clkn(single-ended) or Clkp(differential, Clkp – Clkn).

Identify the LP regions using input data waveform. Let the number of LP regions be N.

From the beginning of every LP region, move backward in the waveform until the absolute
diff(Clkp-Clkn) is greater than 0.1v. Let these points be p(i), i=0 to (N-1).
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From p(i), move forward in waveform until the absolute value of the diff(Clkp-Clkn) is less than
0.07v. Let these points be q(i). q(i) marks the end of trail region.

From p(i) move backward in waveform until the point where single-ended signals Clkp and Clkn cross
each other. Let this point be r(i). r(i) marks the start of trail region.

Trail_Duration(i) = [p(i) – r(i)]

Compute the mean of trail durations observed at all HS to LP transitions.

TrailMean = (1/N)*(Sum(Trail_Duration(i))

Test 1.4.14 Clock Lane HS Exit: 30%-85% Post-EOT Rise Time (TREOT)
Clock Lane HS Exit: 30%-85% Post-EOT Rise Time (TREOT) is calculated using the following algorithm:

Acquire single-ended clock lane signals Clkp and Clkn.

Identify the LP regions using input data waveform. Let the number of LP regions be N.

From the beginning of every LP region, move backward in the waveform until the absolute
diff(Clkp-Clkn) is greater than 0.1V. Let this point be p(i), i=0 to (N-1). From p(i), move forward
in waveform until the absolute value of the diff(Clkp-Clkn) is less than 0.07V. Let this point be q(i).
q(i) marks the start of TREOT region.

From q(i) move forward in waveform until the point where amplitude of single-ended signal Clkp
goes greater than 0.88 volts. Let this point be r(i). r(i) marks the end of TREOT region.

TREOT_Duration(i) = [r(i) – q(i)]

Compute the mean of TREOT durations observed at all HS to LP transitions.

Test 1.4.17 Clock Lane HS Clock Instantaneous (UIINST)
Clock Lane HS Clock Instantaneous (UIINST) is calculated using the following algorithm:

Accept the following inputs:

Clock Lane signals Cp and Cn

Sampling rate

Identify all the HS regions in the input clock waveforms

In the HS regions of the input clock waveforms, identify all the edges. Comput the duration of each
period as the edge-to -edge transition duration (that is the time between a rise and the subsequent fall
or fall and the subsequent rise, taken with reference to 50% of peak)

Compute the following as results:

HSUIMean = mean of all periods computed above

HSUIMinimum = minimum value of the periods computed above

HSUIMaximum = maximum value of the periods computed above
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Group 5 Tests

Test 1.5.1 HS Entry TCLK PREValue
HS Entry TCLK PREPValue is calculated using the following algorithm:

Acquire the Dp and Dn waveforms by setting the Transition trigger from LP to HS mode (LP11-10) on
the oscilloscope.

Using post processing, traverse the Cp and Cn waveforms and find the position corresponding to
Cursor 3. Traverse the Dp and Dn waveforms and find the position corresponding to Cursor 4 as below:

Subtract the Cp and Cn waveforms to obtain Cp–Cn.

In the LP signaling sequence, find in Cp–Cn, the first rising edge and successive falling edge.
Marker 1 is the point where the falling edge touches 550 mV.

Compute VOLHS:

Find the high speed sequence in the input clock waveforms.

Find the highest and the lowest voltage values in the high speed sequence. The mode of all the
values greater than 50% of the peak-to-peak is the VOHHS and the mode of all the values less than
50% of the peak-to peak is the VOLHS.

Find the Cursor 3 position.

From the point corresponding to Marker 1 on Cn, traverse to the right of Cn waveform and find a
point that is less than or equal to the VOLHS. Mark this point as Marker 2.

From Marker 2, traverse both the Cn and Cp waveforms and find the first point which is greater
than or equal to VOHHS on either of the Cn or Cp waveforms. Mark this point as Marker 3.

On the waveform where the Marker 3 point was found, traverse to the left of the waveform until a
point less than or equal to 70 mV is located. This is Marker 4.

On the waveform where the point corresponding to Marker 3 was found, traverse to the right and
find a point where the voltage is less than or equal to (VOHHS +VOLHS)/2. This is Marker 5.

Starting from Marker 5, on the same waveform where the point corresponding to Marker 5 was
found, traverse further and find a point where the voltage is greater than or equal to (VOHHS
+VOLHS)/2. This is Marker 6. Marker 5–Marker 6 and is almost 1 High speed UI. Hence Marker 5
– (Marker 6–Marker 5) is the end point of TCLK-ZERO. Call this Marker 7.

Cursor 3 = Marker 7.

On the Dn and Dp waveforms, find the point corresponding to Marker 7 and check if the value of that
point is greater than 0.8 V. If yes, continue with the following steps, else, the signal is not correct.

On the Data waveform, find a point corresponding to Marker 7. From this point, traverse to the right
and find the first falling edge. The point at which this falling edge crosses 550 mV is Cursor 4.

The time between Cursor 3 and Cursor 4 is TCLK-PRE.
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where,
Dp – Data positive waveform
Dn – Data negative waveform
Cp – Clock positive waveform
Cn – Clock negative waveform

Test 1.5.2 HS Exit TCLK POSTValue
HS Exit TCLK POSTValue is calculated using the following algorithm:

Acquire Cp, Cn, Dp, and Dn waveforms by setting the Transition trigger from LP to HS mode
(LP11-10) on oscilloscope.

Using post processing, traverse the Dp and Dn waveforms and find the position corresponding to
Cursor 1. Traverse the Cp and Cn waveforms and find the position corresponding to Cursor 2 as below:

Compute VOL and VOH for the clock and data waveform.

Find the rising edges on the clock waveform. From the point where the first rising edge is found,
traverse backwards on that waveform and find the point where either of the Cp or Cn waveforms’
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voltage level reaches VOL. This point is Marker 1. At Marker 1 position, one of Cp and Cn voltages
is greater than the other. Let us say Cn value is greater than Cp value at this point.

Traverse backwards from Marker 1 and find on the clock waveforms where Cp value becomes
greater than Cn. This point is Marker 2.

Continue traversing backwards on the clock waveforms and find a point where Cn value becomes
greater than Cp.

Cursor 2 = Marker 2 + (Marker 2–Marker 3).

At a point corresponding to Cursor 2, check if the data waveform value is greater than 0.8 V. If
yes, then proceed, else the signal is not correct.

From the point corresponding to Cursor 2 position on Data waveform, traverse backwards and find
the point where a rising edge value becomes either equal to or just less than VOL. This point is
Cursor 1.

The time between Cursor 1 and Cursor 2 is TCLK-POST as shown in the following figure.

where,

Dp – Data positive waveform

Dn – Data negative waveform

Cp – Clock positive waveform

Cn – Clock negative waveform
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Reference Shortcut Keys

Test 1.5.3 HS Clock Rising Edge Alignment to First Payload Bit
HS Clock Rising Edge Alignment to First Payload Bit is determined by visual verification.

Shortcut Keys
The following table lists the short cut keys to access the application:

Menu Shortcut keys
File Alt + F
New Session Ctrl + N
Open Session Ctrl + O
Save Session Ctrl + S
Save Session As Alt + F + A
Save Report As Alt + F + R

Ctrl + R
Print Preview Report Alt + F + V

Ctrl+ V
Print Report Ctrl + P
Exit Ctrl + X
View Alt + V
Log Ctrl + L
Tools Alt + T
Instrument Bench Ctrl + I
Help Alt + H
TekExpress Help (F1) Alt + H + H
About TekExpress Alt + H + A
xxx

Error Codes
The following table lists the error codes used in the application:

Error code Description
50111 Waveform file not found
50001 Could not find HS region
50002 Could not find LP region
50003 HS UI could not be computed
50004 Pattern 011111/100000 not found
50006 Pattern 111000 not found
50007 Pattern 000111 not found
50008 Possible improper clock
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Error code Description
50009 Could not find HS Trail
50010 Could not find TREOT
50011 Rising edges not found
50012 Falling edges not found
50013 Incorrect waveform
50014 Error running measurement
xxx

Oscilloscope Setup
Four channel with Data as Trigger

Parameter Value
Vertical Scale (mV) 200
Vertical Position for Data (div) –2.6
Vertical Position for Clock (div)
Single Ended
Differential

–2.6
+2.6

Vertical Offset (V) 0
Horizontal Scale (us) 8
Sample Rate (GS/s) 12.5
Record Length 1000000
Trigger Type Transition
Trigger Source Data Source
Trigger Upper Level (V) 1
Trigger Lower Level (V) 0.05
Trigger Time (pS) 500
Trigger Transition Greater Than
Trigger Slope Positive
Trigger If Violation Occurs
xxx

Four channel with Clock as Trigger

Parameter Value
Vertical Scale (mV) 200
Vertical Position for Data (div) –2.6
Vertical Position for Clock (div)
Single Ended
Differential

–2.6
+2.6

Vertical Offset (V) 0
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Reference Oscilloscope Setup

Parameter Value
Horizontal Scale (us) 8
Sample Rate (GS/s) 12.5
Record Length 1000000
Trigger Type Transition
Trigger Source Clock Source
Trigger Upper Level (V)
Single Ended
Differential

1
–0.05

Trigger Lower Level (V)
Single Ended
Differential

0.05\1
–1

Trigger Time (pS) 500
Trigger Transition Greater Than
Trigger Slope
Single Ended
Differential

Positive
Negative

Trigger If Violation Occurs
xxx

Two channel with Data as Trigger

Parameter Value
Vertical Scale (mV) 200
Vertical Position for Data (div) –2.6
Vertical Offset (V) 0
Horizontal Scale (us) 8
Sample Rate (GS/s) 12.5
Record Length 1000000
Trigger Type Transition
Trigger Source Data Source
Trigger Upper Level (V) 1
Trigger Lower Level (V) 0.05
Trigger Time (pS) 500
Trigger Transition Greater Than
Trigger Slope Positive
Trigger If Violation Occurs
xxx

Two channel with Clock as Trigger

Parameter Value
Vertical Scale (mV) 200
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Reference Oscilloscope Setup

Parameter Value
Vertical Position for Clock (div)
Single Ended
Differential

–2.6
+2.6

Vertical Offset (V) 0
Horizontal Scale (us) 8
Sample Rate (GS/s) 12.5
Record Length 1000000
Trigger Type Transition
Trigger Source Clock Source
Trigger Upper Level (V)
Single-Ended
Differential

1
–0.05

Trigger Lower Level (V)
Single-Ended
Differential

0.05\1
–1

Trigger Time (pS) 500
Trigger Transition Greater Than
Trigger Slope
Single-Ended
Differential

Positive
Negative

Trigger If Violation Occurs
xxx

Setup for Clock Continuous Mode

Parameter Value
Vertical Scale (mV) 200
Vertical Position for Data/Clock (div)
Single Ended
Differential

–2.6
+2.6

Vertical Offset (V) 0
Horizontal Scale (us) 8
Sample Rate (GS/s) 12.5
Record Length 1000000
Trigger Type Edge
Trigger Source Data/Clock Source
Trigger Level (V)
Single Ended
Differential

200 mV
0 V

xxx

182 TekExpress D-PHY Automated Solution



Index

Index

A
About TekExpress, 11
Acquire parameters, 34
Acquire source options, 34
Activating license, 7
Algorithm

Clock Lane Fall Time, 159
Clock Lane HS Clock

Instantaneous
(UIINST), 175

Clock Lane HS Entry:
TCLK-PREPARE
Value, 169

Clock Lane HS Entry: TCLK-
PREPARE+TCLK-ZERO
Value, 170

Clock Lane HS Entry: TLPX
Value, 169

Clock Lane HS Exit:
30%-85% Post-EOT
Rise Time (TREOT), 175

Clock Lane HS Exit:
THS-TRAIL Value, 174

Clock Lane HS-TX 20%-80%
Rise Time (tR), 174

Clock Lane HS-TX 80%-20%
Fall Time (tF), 174

Clock Lane HS-TX
Differential Voltages
(VOD(0), VOD(1)), 170

Clock Lane HS-TX
Differential Voltages
Mismatch (VOD), 171

Clock Lane HS-TX
Dynamic Common-Level
Variations Above
450MHz, 173

Clock Lane HS-TX
Dynamic Common-Level
Variations Between
50-450MHz, 173

Clock Lane HS-TX
Single-Ended Output

High Voltages
(VOHHS(DP),
VOHHS(DN)), 171

Clock Lane HS-TX
Static Common-Mode
Voltage Mismatch
(VCMTX(1,0)), 172

Clock Lane HS-TX
Static Common-Mode
Voltages (VCMTX(1),
VCMTX(0)), 172

Clock Lane LP-TX Thevenin
Output High Level
Voltage, 158

Clock Lane LP-TX Thevenin
Output Low Level
Voltage, 158

Clock Lane Rise Time, 159
Data Lane Fall Time, 157
Data Lane HS Entry: Data

Lane TLPX Value, 160
Data Lane HS Entry:

THS-PREPARE +
THS-ZERO Value, 162

Data Lane HS Entry:
THS-PREPARE
Value, 161

Data Lane HS Exit: 30%-85%
Post-EOT Rise Time
(TREOT), 169

Data Lane HS Exit:
THS-TRAIL Value, 168

Data Lane HS-TX 20%-80%
Rise Time (tR), 167

Data Lane HS-TX 80%-20%
Fall Time (tF), 167

Data Lane HS-TX Differential
Voltage Mismatch
(VOD), 164

Data Lane HS-TX Differential
Voltages (VOD(0),
VOD(1)), 163

Data Lane HS-TX Dynamic
Common-Level

Variations Above
450MHz, 166

Data Lane HS-TX Dynamic
Common-Level
Variations Between
50-450MHz, 166

Data Lane HS-TX
Single-Ended Output
High Voltages
(VOHHS(DP),
VOHHS(DN)), 165

Data Lane HS-TX Static
Common Mode
Voltages (VCMTX(0),
VCVMTX(1)), 165

Data Lane HS-TX Static
Common-Mode
Voltage Mismatch
(VCMTX(1,0)), 166

Data Lane LP-TX Thevenin
Output High Level
Voltage, 155

Data Lane LP-TX Thevenin
Output Low Level
Voltage, 155

Data Lane Rise Time, 156
HS Clock Rising Edge

Alignment to First
Payload Bit, 179

HS Entry TCLK
PREValue, 176

HS Exit TCLK
POSTValue, 177

Analyze parameters, 24
Application summary, 11
ApplicationStatus(), 142

B
Band pass filter, 97
Before clicking Run, 9
Button

Configure, 23
Deselect All, 23

TekExpress D-PHY Automated Solution 183



Index

Select All, 23
Show Schematic, 23

C
CheckSessionSaved(), 148
Client, 115
Clock lane probing

Differential, 22
Single-ended, 22

Clock mode
Continuous, 22
normal, 21
Normal, 22

Configure
Acquire tab, 24
Analyze tab, 24
Cancel button, 25
Clock lane fall time, 58
Clock Lane HS Clock

Instantaneous
(UIINST), 107

Clock Lane HS Entry
TCLK-PREPARE
Value, 85

Clock Lane HS Entry TCLK-
PREPARE+TCLK-ZERO
Value, 86

Clock Lane HS Entry TLPX
Value, 83

Clock Lane HS Exit:
30%-85% Post-EoT
Rise Time (TREOT), 105

Clock Lane HS Exit:
TCLK-TRAIL
Value, 104

Clock Lane HS-TX 20%-80%
Rise time (tR), 101

Clock Lane HS-TX 80%-20%
Fall time (tF), 102

Clock Lane HS-TX
Differential Voltage
Mismatch, 90

Clock Lane HS-TX
Differential Voltages
(VOD(0), VOD(1)), 88

Clock Lane HS-TX
Dynamic Common-
Level Variations

Above 450MHz
(VCMTX(HF)), 99

Clock Lane HS-TX
Single-Ended Output
High Voltages
(VOHHS(DP),
VOHHS(DN)), 92

Clock Lane HS-TX
Static Common-Mode
Voltages (VCMTX(1),
VCMTX(0)), 93

Clock lane LP-TX Thevenin
output high level voltage
(VOH), 53

Clock lane LP-TX Thevenin
output low level voltage
(VOL), 55

Clock lane rise time, 56
Clock Rising Edge Alignment

to First Payload Bit, 112
Comments tab, 25
Data lane fall time, 50
Data Lane HS Entry: Data

Lane TLPX Value, 60
Data Lane HS Entry:

THS-PREPARE +
THS-ZERO, 63

Data Lane HS Entry:
THS-PREPARE
Value, 62

Data Lane HS Exit: 30%-80%
Post-EOT Rise Test
(TREOT), 81

Data Lane HS Exit:
THS-TRAIL Value, 79

Data Lane HS-TX 20%-80%
Rise time (tR), 76

Data Lane HS-TX 80%-20%
Fall time (tF), 78

Data Lane HS-TX Differential
Voltage Mismatch
(VOD), 66

Data Lane HS-TX Differential
Voltages (VOD(0),
VOD(1)), 65

Data Lane HS-TX
Dynamic Common-
Level Variations

Above 450MHz
(VCMTX(HF)), 74

Data Lane HS-TX Dynamic
Common-Level
Variations Between
50-450MHz
(VCMTX(LF)), 97

Data Lane HS-TX
Single-Ended Output
High Voltages
((VOHHS(DP),
VOHHS(DN)), 68

Data Lane HS-TX Static
Common-Mode
Voltages (VCMTX(1),
VCMTX(0)), 69

Data lane LP-TX Thevenin
output high level voltage
(VOH), 46

Data lane LP-TX Thevenin
output low level voltage
(VOL), 47

Data lane rise time, 49
HS Entry TCLK

PREValue, 109
HS Exit TCLK

POSTValue, 111
Limits tab, 25
Restore button, 25
Save button, 25

Configure and run the Test(s), 23
Connect(), 127
Connections

Clock lane fall time, 58
Clock Lane HS Clock

Instantaneous
(UIINST), 107

Clock Lane HS Entry
TCLK-PREPARE
Value, 85

Clock Lane HS Entry TCLK-
PREPARE+TCLK-ZERO
Value, 86

Clock Lane HS Entry TLPX
Value, 83

Clock Lane HS Exit:
30%-85% Post-EoT
Rise Time (TREOT), 105

184 TekExpress D-PHY Automated Solution



Index

Clock Lane HS Exit:
TCLK-TRAIL
Value, 104

Clock Lane HS-TX 20%-80%
Rise time (tR), 101

Clock Lane HS-TX 80%-20%
Fall time (tF), 102

Clock Lane HS-TX
Differential Voltage
Mismatch, 90

Clock Lane HS-TX
Differential Voltages
(VOD(0), VOD(1)), 88

Clock Lane HS-TX
Dynamic Common-
Level Variations
Above 450MHz
(VCMTX(HF)), 99

Clock Lane HS-TX
Dynamic Common-Level
Variations Between
50-450MHz
(VCMTX(LF)), 97

Clock Lane HS-TX
Single-Ended Output
High Voltages
(VOHHS(DP),
VOHHS(DN)), 92

Clock Lane HS-TX
Static Common-Mode
Voltage Mismatch
(VCMTX(1,0)), 95

Clock Lane HS-TX
Static Common-Mode
Voltages (VCMTX(1),
VCMTX(0)), 93

Clock lane LP-TX Thevenin
output high level voltage
(VOH), 53

Clock lane LP-TX Thevenin
output low level voltage
(VOL), 55

Clock lane rise time, 56
Clock Rising Edge Alignment

to First Payload Bit, 112
Data lane fall time, 50
Data Lane HS Entry: Data

Lane TLPX Value, 60

Data Lane HS Entry:
THS-PREPARE +
THS-ZERO, 63

Data Lane HS Entry:
THS-PREPARE
Value, 62

Data Lane HS Exit: 30%-80%
Post-EOT Rise Test
(TREOT), 81

Data Lane HS Exit:
THS-TRAIL Value, 79

Data Lane HS-TX 20%-80%
Rise time (tR), 76

Data Lane HS-TX 80%-20%
Fall time (tF), 78

Data Lane HS-TX Differential
Voltage Mismatch
(VOD), 66

Data Lane HS-TX Differential
Voltages (VOD(0),
VOD(1)), 65

Data Lane HS-TX
Dynamic Common-
Level Variations
Above 450MHz
(VCMTX(HF)), 74

Data Lane HS-TX Dynamic
Common-Level
Variations Between
50-450MHz
(VCMTX(LF)), 72

Data Lane HS-TX
Single-Ended Output
High Voltages
((VOHHS(DP),
VOHHS(DN)), 68

Data Lane HS-TX Static
Common-Mode
Voltage Mismatch
(VCMTX(1,0)), 71

Data Lane HS-TX Static
Common-Mode
Voltages (VCMTX(1),
VCMTX(0)), 69

Data lane LP-TX Thevenin
output high level voltage
(VOH), 46

Data lane LP-TX Thevenin
output low level voltage
(VOL), 47

Data lane rise time, 49
HS Entry TCLK

PREValue, 109
HS Exit TCLK

POSTValue, 111
Controlling the Server, 116
Conventions, 1

D
D-PHY Application

Commands, 121
Data storage, 38
Default directory usage, 5
Device

D-PHY CSI-2, 22
D-PHY DSI, 22

Directories and usage, 5
Disconnect(), 149
Disk space, 14
dongle, 12
DUT, 14

E
E-mail Settings, 16
Exiting the application, 13

F
Features, 11
File name extensions, 7
Flowchart for Client

Programmatic Interface, 118

G
GetAcquireParameter(), 133
GetAnalyzeParameter(), 133
GetCurrentStateInfo(), 143
GetDutId(), 130
GetGeneralParameter(), 133
GetPassFailStatus(), 144
GetReportParameter(), 145
GetResultsValue(), 144
GetResultsValueForSubMeasure-

ments(), 145

TekExpress D-PHY Automated Solution 185



Index

GetTimeOut(), 142
Global controls, 14
Group 1 test

Clock lane LP-TX Thevenin
output high level voltage
(VOH), 53

Clock lane LP-TX Thevenin
output low level voltage
(VOL), 55

Data lane fall time, 50
Data lane LP-TX Thevenin

output high level voltage
(VOH), 46

Data lane LP-TX Thevenin
output low level voltage
(VOL), 47

Data lane rise time, 49
Group 1 tests, 19
Group 2 test

Clock lane fall time, 58
Clock lane rise time, 56

Group 2 tests, 19
Group 3 test

Clock Lane HS-TX
Dynamic Common-Level
Variations Between
50-450MHz
(VCMTX(LF)), 97

Clock Lane HS-TX
Static Common-Mode
Voltage Mismatch
(VCMTX(1,0)), 95

Clock Lane HS-TX
Static Common-Mode
Voltages (VCMTX(1),
VCMTX(0)), 93

Data Lane HS Entry: Data
Lane TLPX Value, 60

Data Lane HS Entry:
THS-PREPARE
Value, 62

Data Lane HS Exit: 30%-80%
Post-EOT Rise Test
(TREOT), 81

Data Lane HS Exit:
THS-TRAIL Value, 79

data Lane HS-TX 20%-80%
Rise time (tR), 76

Data Lane HS-TX 80%-20%
Fall time (tF), 78

Data Lane HS-TX
Dynamic Common-
Level Variations
Above 450MHz
(VCMTX(HF)), 74

Data Lane HS-TX Dynamic
Common-Level
Variations Between
50-450MHz
(VCMTX(LF)), 72

Data Lane HS-TX Static
Common-Mode
Voltage Mismatch
(VCMTX(1,0)), 71

Data Lane HS-TX Static
Common-Mode
Voltages (VCMTX(1),
VCMTX(0)), 69

Group 3 tests, 19
Group 4 test

Clock Lane HS Clock
Instantaneous
(UIINST), 107

Clock Lane HS Entry
TCLK-PREPARE
Value, 85

Clock Lane HS Entry TCLK-
PREPARE+TCLK-ZERO
Value, 86

Clock Lane HS Entry TLPX
Value, 83

Clock Lane HS Exit:
30%-85% Post-EoT
Rise Time (TREOT), 105

Clock Lane HS Exit:
TCLK-TRAIL
Value, 104

Clock Lane HS-TX 20%-80%
Rise time (tR), 101

Clock Lane HS-TX 80%-20%
Fall time (tF), 102

Clock Lane HS-TX
Differential Voltage
Mismatch, 90

Clock Lane HS-TX
Differential Voltages
(VOD(0), VOD(1)), 88

Clock Lane HS-TX
Dynamic Common-
Level Variations
Above 450MHz
(VCMTX(HF)), 99

Clock Lane HS-TX
Single-Ended Output
High Voltages
(VOHHS(DP),
VOHHS(DN)), 92

Group 4 tests, 20
Group 5 test

Clock Rising Edge Alignment
to First Payload Bit, 112

HS Entry TCLK
PREValue, 109

HS Exit TCLK
POSTValue, 111

Group 5 tests, 20

H
High pass filter, 99

I
Installation

software, 4
upgrade, 4

Instrument discovery, 30
Interface, 115
Interface error codes, 150

L
LockSession(), 128

M
MappingMyTekExpress folder, 9
Measurement method

automatic, 24
manual, 42

Menu
File, 14
Help, 17
Tools, 15

186 TekExpress D-PHY Automated Solution



Index

View, 15
Minimum system requirements, 3
My TekExpress, 38
My TekExpress folder, 6

O
Oscilloscopes supported, 3
Overview, 11

P
Perform analysis

using live waveform files, 31
using prerecorded waveform

files, 33
Prerecorded waveform files, 34
Program example, 150
Programmatic Interface, 115
Proxy Object

Client, 117
Remote, 116

Q
QueryStatus(), 143

R
Reactivating License, 7
RecallSession(), 148
Related Documentation, 1
Report panel overview, 37
Resizing the application, 13
Run

Run button, 14
Run button, 14
Run(), 141

S
SaveSession(), 148
SaveSessionAs(), 148
Select

connected instruments, 30
Select Test(s), 19

Group 1, 19
Group 2, 19
Group 3, 19
Group 4, 20
Group 5, 20

Selecting acquisition source, 34
Selecting connected

instruments, 31
SelectTest(), 135
SendResponse(), 143
Server, 115
Session folder, 38
SetAcquireParameter(), 139
SetAnalyzeParameter(), 139
SetDutId(), 130
SetGeneralParameter(), 130
SetTimeOut(), 142
SetVerboseMode(), 129
Shortcut keys, 179
Signal Path Compensation

(SPC), 10
Software

upgrade, 4
Starting the application, 12
Stop(), 141

T
Technical support, 2
TekVISA InstrumentManager, 30

Temperature chamber testing
filter file, 24

Test limits, 25
Test mode

escape, 21
Escape, 22
normal, 21
Normal, 22

Test(s)
Report, 37

TestStand Client example, 153
Tools

Instrument Bench, 16
TransferImages(), 146
TransferReport(), 146
TransferWaveforms(), 146

U
UnlockSession(), 149
Untitled Session, 6
USB dongle, 12

V
Version

CTS, 22
View

connected instruments, 30
progress of analysis, 35
report, 37
test related files, 38

W
Waveform file, 34

TekExpress D-PHY Automated Solution 187


	toc
	Introduction to the Application
	Related Documentation
	Conventions
	Technical Support

	Getting Started
	Compatibility
	Minimum System Requirements
	Install the Software
	Application Directories and Usage
	Folder Structure
	File Name Extensions
	Activate the License
	Before You Click Run

	Operating Basics
	D-PHY Application Overview
	Starting the Application
	Resizing the Application Window
	Exiting the Application
	Global Controls
	Menus
	File Menu
	View Menu
	Tools Menu
	Help Menu


	How To
	Select Test(s)
	Configure and Run the Test(s)
	Typical Configuration Parameters
	View and Select Connected Instruments
	Acquire Live Waveform for Analysis
	Use Prerecorded Waveforms for Analysis
	View the Progress of Analysis
	View the Report
	View Test Related Files

	Application Examples
	Connection Setup
	Configuring Parameter Values
	Temperature Chamber Testing
	Group 1 Tests
	Testing Data Lane LP-TX Thevenin Output High Level Voltage (VOH)
	Connections for Data Lane LP-TX Thevenin Output High Level Volta
	Configure and Run Data Lane LP-TX Thevenin Output High Level Vol

	Testing Data Lane LP-TX Thevenin Output Low Level Voltage (VOL)
	Connections for Data Lane LP-TX Thevenin Output Low Level Voltag
	Configure and Run Data Lane LP-TX Thevenin Output Low Level Volt

	Testing Data Lane Rise Time 
	Connections for Data Lane Rise Time
	Configure and Run Data Lane Rise Time

	Testing Data Lane Fall Time 
	Connections for Data Lane Fall Time
	Configure and Run Data Lane Fall Time

	View Report for Group 1 Tests

	Group 2 Tests
	Testing Clock Lane LP-TX Thevenin Output High Level Voltage (VOH
	Connections for Clock Lane LP-TX Thevenin Output High Level Volt
	Configure and Run Clock Lane LP-TX Thevenin Output High Level Vo

	Testing Clock Lane LP-TX Thevenin Output Low Level Voltage (VOL)
	Connections for Clock Lane LP-TX Thevenin Output Low Level Volta
	Configure and Run Clock Lane LP-TX Thevenin Output Low Level Vol

	Testing Clock Lane Rise Time 
	Connections for Clock Lane Rise Time
	Configure and Run Clock Lane Rise Time

	Testing Clock Lane Fall Time 
	Connections for Clock Lane Fall Time
	Configure and Run Clock Lane Fall Time

	View Report for Group 2 Tests

	Group 3 Tests
	Testing Data Lane HS Entry: Data Lane TLPX Value 
	Connections for Data Lane HS Entry: Data Lane TLPX Value 
	Configure and Run Data Lane HS Entry: Data Lane TLPX Value

	Testing Data Lane HS Entry: THS-PREPARE Value 
	Connections for Data Lane HS Entry: THS-PREPARE Value
	Configure and Run Data Lane HS Entry: THS-PREPARE Value

	Testing Data Lane HS Entry: THS-PREPARE + THS-ZERO Value 
	Connections for Data Lane HS Entry: THS-PREPARE + THS-ZERO Value
	Configure and Run Data Lane HS Entry: THS-PREPARE + THS-ZERO Val

	Testing Data Lane HS-TX Differential Voltages (VOD(0), VOD(1))
	Connections for Data Lane HS-TX Differential Voltages (VOD(0), V
	Configure and Run Data Lane HS-TX Differential Voltages (VOD(0),

	Testing Data Lane HS-TX Differential Voltage Mismatch (VOD)
	Connections for Data Lane HS-TX Differential Voltage Mismatch (V
	Configure and Run Data Lane HS-TX Differential Voltage Mismatch 

	Testing Data Lane HS-TX Single-Ended Output High Voltages ((VOHH
	Connections for Data Lane HS-TX Single-Ended Output High Voltage
	Configure and Run Data Lane HS-TX Single-Ended Output High Volta

	Testing Data Lane HS-TX Static Common-Mode Voltages (VCMTX(1), V
	Connections for Data Lane HS-TX Static Common-Mode Voltages (VCM
	Configure and Run Data Lane HS-TX Static Common-Mode Voltages (V

	Testing Data Lane HS-TX Static Common-Mode Voltage Mismatch (VCM
	Connections for Data Lane HS-TX Static Common-Mode Voltage Misma
	Configure and Run Data Lane HS-TX Static Common-Mode Voltage Mis

	Testing Data Lane HS-TX Dynamic Common-Level Variations Between 
	Connections for Data Lane HS-TX Dynamic Common-Level Variations 
	Configure and Run Data Lane HS-TX Dynamic Common-Level Variation

	Testing Data Lane HS-TX Dynamic Common-Level Variations Above450
	Connections for Data Lane HS-TX Dynamic Common-Level Variations 
	Configure and Run Data Lane HS-TX Dynamic Common-Level Variation

	Testing Data Lane HS-TX 20%-80% Rise time (tR)
	Connections for Data Lane HS-TX 20%-80% Rise time (tR)
	Configure and Run Data Lane HS-TX 20%-80% Rise time (tR)

	Testing Data Lane HS-TX 80%-20% Fall time (tF)
	Connections for Data Lane HS-TX 80%-20% Fall time (tF)
	Configure and Run Data Lane HS-TX 80%-20% Fall time (tF)

	Testing Data Lane HS Exit: THS-TRAIL Value
	Connections for Data Lane HS Exit: THS-TRAIL Value
	Configure and Run Data Lane HS Exit: THS-TRAIL Value

	Testing Data Lane HS Exit: 30%-80% Post-EOT Rise Test (TREOT)
	Connections for Data Lane HS Exit: 30%-80% Post-EOT Rise Test (T
	Configure and Run Data Lane HS Exit: 30%-80% Post-EOT Rise Test 

	View Report for Group 3 Tests

	Group 4 Tests
	Testing Clock Lane HS Entry TLPX Value
	Connections for Clock Lane HS Entry TLPX Value
	Configure and Run Clock Lane HS Entry TLPX Value

	Testing Clock Lane HS Entry TCLK-PREPARE Value
	Connections for Clock Lane HS Entry TCLK-PREPARE Value
	Configure and Run Clock Lane HS Entry TCLK-PREPARE Value 

	Testing Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO Value
	Connections for Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO Value
	Configure and Run Clock Lane HS Entry TCLK-PREPARE+TCLK–ZERO Val

	Testing Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1))
	Connections for Clock Lane HS-TX Differential Voltages (VOD(0), 
	Configure and Run Clock Lane HS-TX Differential Voltages (VOD(0)

	Testing Clock Lane HS-TX Differential Voltage Mismatch
	Connections for Clock Lane HS-TX Differential Voltage Mismatch
	Configure and Run Clock Lane HS-TX Differential Voltage Mismatch

	Testing Clock Lane HS-TX Single-Ended Output High Voltages (VOHH
	Connections for Clock Lane HS-TX Single-Ended Output High Voltag
	Configure and Run Clock Lane HS-TX Single-Ended Output High Volt

	Testing Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1), 
	Connections for Clock Lane HS-TX Static Common-Mode Voltages (VC
	Configure and Run Clock Lane HS-TX Static Common-Mode Voltages (

	Testing Clock Lane HS-TX Static Common-Mode Voltage Mismatch (VC
	Connections for Clock Lane HS-TX Static Common-Mode Voltage Mism
	Configure and Run Clock Lane HS-TX Static Common-Mode Voltage Mi

	Testing Clock Lane HS-TX Dynamic Common-Level Variations Between
	Connections for Clock Lane HS-TX Dynamic Common-Level Variations
	Configure and Run Clock Lane HS-TX Dynamic Common-Level Variatio

	Testing Clock Lane HS-TX Dynamic Common-Level Variations Above45
	Connections for Clock Lane HS-TX Dynamic Common-Level Variations
	Configure and Run Clock Lane HS-TX Dynamic Common-Level Variatio

	Testing Clock Lane HS-TX 20%-80% Rise time (tR)
	Connections for Clock Lane HS-TX 20%-80% Rise time (tR)
	Configure and Run Clock Lane HS-TX 20%-80% Rise time (tR)

	Testing Clock Lane HS-TX 80%-20% Fall time (tF)
	Connections for Clock Lane HS-TX 80%-20% Fall time (tF)
	Configure and Run Clock Lane HS-TX 80%-20% Fall time (tF)

	Testing Clock Lane HS Exit: TCLK-TRAIL Value
	Connections for Clock Lane HS Exit: TCLK-TRAIL Value
	Configure and Run Clock Lane HS Exit: TCLK-TRAIL Value

	Testing Clock Lane HS Exit: 30%-85% Post-EoT Rise Time (TREOT)
	Connections for Clock Lane HS Exit: 30%-85% Post-EoT Rise Time (
	Configure and Run Clock Lane HS Exit: 30%-85% Post-EoT Rise Time

	Testing Clock Lane HS Clock Instantaneous (UIINST)
	Connections for Clock Lane HS Clock Instantaneous (UIINST)
	Configure and Run Clock Lane HS Clock Instantaneous (UIINST)

	View Report for Group 4 Tests

	Group 5 Tests
	Testing HS Entry TCLK PREValue 
	Connections for HS Entry TCLK PREValue 
	Configure and Run HS Entry TCLK PREValue

	Testing HS Exit TCLK POSTValue 
	Connections for HS Exit TCLK POSTValue 
	Configure and Run HS Entry TCLK POSTValue 

	Testing Clock Rising Edge Alignment to First Payload Bit
	Connections for Clock Rising Edge Alignment to First Payload Bit
	Configure and Run Clock Rising Edge Alignment to First Payload B

	View Report for Group 5 Tests


	TekExpress Programmatic Interface
	About the Programmatic Interface
	Server and Client Proxy Objects
	Remote Proxy Object
	Client Proxy Object

	Client Programmatic Interface: An Example
	D-PHY Application Command Arguments and Queries
	Connect Through an IP Address
	Lock the Server
	Disable the Popups
	Set or Get the DUT ID
	Set the Configuration Parameters for a Suite or Measurement
	Query the Configuration Parameters for a Suite or Measurement
	Select a Measurement
	Select a Suite
	Select a Channel
	Configure the Selected Measurement
	Run with Set Configurations or Stop the Run Operation
	Get or Set the Timeout Value
	Wait for the Test to Complete
	After the Test is Complete
	Save, Recall, or Check if a Session is Saved
	Unlock the Server
	Disconnect from the Server
	Handle Error Codes
	Program Example

	Reference
	Algorithms
	Group 1 Tests
	Test 1.1.1 Data Lane LP-TX Thevenin Output High Level Voltage (V
	Test 1.1.2 Data Lane LP-TX Thevenin Output Low Level Voltage (VO
	Test 1.1.3 Data Lane Rise Time
	Test 1.1.4 Data Lane Fall Time

	Group 2 Tests
	Test 1.2.1 Clock Lane LP-TX Thevenin Output High Level Voltage (
	Test 1.2.2 Clock Lane LP-TX Thevenin Output Low Level Voltage (V
	Test 1.2.3 Clock Lane Rise Time
	Test 1.2.4 Clock Lane Fall Time

	Group 3 Tests
	Test 1.3.1 Data Lane HS Entry: Data Lane TLPX Value
	Test 1.3.2 Data Lane HS Entry: THS-PREPARE Value
	Test 1.3.3 Data Lane HS Entry: THS-PREPARE + THS-ZERO Value
	Test 1.3.4 Data Lane HS-TX Differential Voltages (VOD(0), VOD(1)
	Test 1.3.5 Data Lane HS-TX Differential Voltage Mismatch (VOD)
	Test 1.3.6 Data Lane HS-TX Single-Ended Output High Voltages (VO
	Test 1.3.7 Data Lane HS-TX Static Common Mode Voltages (VCMTX(0)
	Test 1.3.8 Data Lane HS-TX Static Common-Mode Voltage Mismatch (
	Test 1.3.9 Data Lane HS-TX Dynamic Common-Level Variations Betwe
	Test 1.3.10 Data Lane HS-TX Dynamic Common-Level Variations Abov
	Test 1.3.11 Data Lane HS-TX 20%-80% Rise Time (tR)
	Test 1.3.12 Data Lane HS-TX 80%-20% Fall Time (tF)
	Test 1.3.13 Data Lane HS Exit: THS-TRAIL Value
	Test 1.3.14 Data Lane HS Exit: 30%-85% Post-EOT Rise Time (TREOT

	Group 4 Tests
	Test 1.4.1 Clock Lane HS Entry: TLPX Value
	Test 1.4.2 Clock Lane HS Entry: TCLK-PREPARE Value
	Test 1.4.3 Clock Lane HS Entry: TCLK-PREPARE+TCLK-ZERO Value
	Test 1.4.4 Clock Lane HS-TX Differential Voltages (VOD(0), VOD(1
	Test 1.4.5 Clock Lane HS-TX Differential Voltage Mismatch (VOD)
	Test 1.4.6 Clock Lane HS-TX Single-Ended Output High Voltages (V
	Test 1.4.7 Clock Lane HS-TX Static Common-Mode Voltages (VCMTX(1
	Test 1.4.8 Clock Lane HS-TX Static Common-Mode Voltage Mismatch 
	Test 1.4.9 Clock Lane HS-TX Dynamic Common-Level Variations Betw
	Test 1.4.10 Clock Lane HS-TX Dynamic Common-Level Variations Abo
	Test 1.4.11 Clock Lane HS-TX 20%-80% Rise Time (tR)
	Test 1.4.12 Clock Lane HS-TX 80%-20% Fall Time (tF)
	Test 1.4.13 Clock Lane HS Exit: THS-TRAIL Value
	Test 1.4.14 Clock Lane HS Exit: 30%-85% Post-EOT Rise Time (TREO
	Test 1.4.17 Clock Lane HS Clock Instantaneous (UIINST)

	Group 5 Tests
	Test 1.5.1 HS Entry TCLK PREValue
	Test 1.5.2 HS Exit TCLK POSTValue
	Test 1.5.3 HS Clock Rising Edge Alignment to First Payload Bit 


	Shortcut Keys
	Error Codes
	Oscilloscope Setup 



